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1. Proposed and Intended Usage 

 
This document is intended to illustrate the usage of CER-S software (Continuous ECG 
Recording – Suite; internal name is Electra). 
 
CER-S is designed to offer a framework for the interaction of different software-modules 
providing advanced solutions for continuous ECG recording (CER). 
 
It provides a way to display continuous ECG recordings and to perform automatic ECG beat 
detection with ECG template generation and Arrhythmia detection using AMPS ABILE 
algorithm, and to review and manually edit the computed information using several 
Graphical tools, designed to easily spot outlier. 
The software also enables computation of the beats’ measurements using AMPS BRAVO 
algorithm. 
 
Last it provides a way to generate aECG HL7 XML (v. 2) files, which can be used for the 
submission of continuous ECG recordings to the FDA Warehouse. 
 
In addition, the tool provides a command-line for batch analysis. 
 
In the initial sections of this document the graphical interface will be presented while in the 
last section, command-line usage will be introduced. 
 

2. Abbreviations and Conventions Used in the Manual 

 

ECG Electrocardiograph 

CER Continuous ECG Recording 

Median Representative Beat data 

Rhythm Standard ECG data 

TPW Timepoint Window 

AW Analysis Window 

RA Rhythm Annotation o Arrhythmia Annotation 

NR Noise Region 

RBE Rhythm & Beat Editor Display 

ACEA AMPS Binary Session file  

ABILE AMPS algorithm for ECG beats and Arrhythmias and 

detection 

BRAVO AMPS algorithm for the automatic measurement of ECG 

intervals and amplitudes 
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3. Procedures for System Use 

 Getting Started 

CER-S software installation is trivial: the setup file (Setup_CER-S_320.exe) provided by 
AMPS personnel must be launched as Administrator.  
Thus the setup file shall not be double-clicked, but instead the secondary mouse button 

shall be clicked on the file and the entry “ ” shall be clicked. 
 
Here, following defaults settings, CER-S software is installed together with all the required 
libraries and modules. 
 
After the user has completed the installation of the software, the application can be launched 
by double-clicking the CER-S.exe program file. The program file is typically installed in the 
“C:\Program Files (x86)\AMPS\CER-S” folder. 
The user can also launch the software via the CER-S desktop icon or from the Start Menu. 
 
The software can also be launched by command-line. Refer to section 3.1 of the System 
Manual for all the details and the list of command-line flags. Section 3.2 contains examples  
of command-line. 
 
When the software is loaded, it displays an empty graphical interface and up to eleven 
menus on the top left (depending on the licensed version), as displayed in Figure 1. 
 

 
Figure 1 – CER-S display, initial empty screen 

 

 Supported Input formats 

The software supports the display and analysis of continuous ECG recordings for the 
following ten formats: 
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- ISHNE 
- MIT (WFDB) 
- aECG FDA HL7 XML, version 2 
- Getemed 
- MyPatchSL 
- STXML 
- Binary DAT 
- Binary WV 
- CSV 
- JSON 
 
To load an ECG record, in the File menu select the Open Record menu entry. This will 
display a new dialog box (shown in Figure 2), where the user can select the ECG recording 
to load, filtering by file type. 
 
When the user has selected the record, the first seconds ECG the data are displayed in the 
Continuous ECG Viewer or Rhythm & Beat Editor tabs according with the display settings as 
shown in Figure 10. 
 

 
Figure 2 – CER-S continuous ECG record loading dialog 

 
It is possible to load ECG records from an archive using the CER-S Recordings Manager. 
Refer to the next section for details. 
 

 Recordings Manager 

To open the recordings manager, select Recordings Manager menu entry in the File menu 

or click the  toolbar button. 
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The Recordings Manager (Figure 3) is a dialog where is possible to select the ECG Record 
to be opened with CER-S. The records are arranged in user-created archives and are 
displayed in a table 
  
For each record, the following information are displayed as columns, by default in the list: 

• Progressive number of the record in the selected DB 

• Subject ID 
• Subject Name 
• Data/Time of recording 
• Record length 
• Number of leads 
• Sampling Rate (Hz) 

• File Format (Type) 
• Status (refer to section 3.3.2 for details) 
• Analysis performed (refer to section 3.3.3 for details) 

 

 
Figure 3 – CER-S Recordings Manager 

 
The order of the list can be changed clicking on the header of the desired sorting parameter 
and the content of the list can be filtered, by tying some text on the text box below the 
Select archive menu. Filtering is simultaneously performed on: 

• N - line number (first column) 
• ID - Subject ID (second column) 
• Subject Name (third column) 

 
In order to open one or more record in CER-S there are various options: 

• double click on a row of the list to load the corresponding record 
• select one or multiple rows via SHIFT or CTRL keys and click the “Open Selected 

Record/s” entry to load the corresponding records 
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• select one or multiple rows via SHIFT or CTRL keys, click the secondary mouse button 
on the selection and select the “Open Record/s” entry to load the corresponding 
records 
 

• In case more than one are selected, the first one (top most) will be loaded and then 
in CER-S the user will have the option to load the next/previous selected records, via 
“Go to next selected record” or “Go to previous selected record” entries from the File 
menu. 

 

   
 

 
To populate the table, an archive must be selected from the dedicated menu: 
 

 
 
From the menu is possible to: 

- Select an archive from the list 
- Open an existing archive which is not present in the list (upon selecting the 

corresponding entry, the user is prompted to select the folder where the archive is 
located) 

- Create a new archive (the user is prompted to select the archive location, which must 
be an empty folder). 

 
It is possible to show the recordings manager at CER-S startup by flagging the 
correspondent checkbox. 

 
 

 Import record 

When an archive is selected, it is possible to import a record by pressing the “Import Single 
Record” or “Import Records” buttons. 
 

 
 
In case the former button is pressed, the user will have to select recording the file from the 
file system, then, when the file has been selected, on the dedicated dialog (Figure 4), it will 
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be possible to customize the actions to be performed after the record importation in CER-S 
Recordings Manager, namely in case the “Remove original record” is enabled, the original 
record file will be deleted and if “Run automatic analysis” is set to Yes, Beat Detection (ref. 
to sec. 3.20) and Rhythm Analysis (ref. to sec. 3.20.2) will be automatically launched using 
the current settings. 
 

 
Figure 4 – Recordings Manager, importing a single record 

 
Depending on the length of the record that is being imported, Multiday Analysis may be 
automatically launched instead of Beat Detection and Rhythm Analysis. 
Add the end of the importation process, demographic information are shown and can be 
manually edited by the user, by clicking Update button. 
 
Clicking the “Import Records” button, a new dialog (Figure 7) is displayed where the user 
can edit the input folder (the last used one is remembered), choose whether records in 
subfolders shall also be imported and if duplicate recordings shall be imported. Duplicate 
recordings are records with identical date of recording, length, subject ID and subject name. 
In the ‘Filter’ field, the extension of the record files to import must be selected. 
 

 
Figure 5 – Recordings Manager, importing multiple records 

 
Similarly to the single import record, it is also be possible to customize the actions to be 
performed after the records importation in CER-S Recordings Manager, namely in case the 
“Remove original record” is enabled, the original record files will be deleted and if “Run 
automatic analysis” is set to Yes, Beat Detection (ref. to sec. 3.20) and Rhythm Analysis 
(ref. to sec. 3.20.2) will be automatically launched using the current settings. 
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Depending on the length of the records that are being imported, Multiday Analysis may be 
automatically launched instead of Beat Detection and Rhythm Analysis. 
 
When the import process is completed, the recordings manager is automatically updated 
with the new imported record(s) as shown here below. 
 

 
Figure 6 – Recordings Manager - Example of an imported record on which beat detection and rhythm 

analysis have been performed 

 

 
Figure 7 – Example of import results dialog 

 

 Record Status 

 
Individual ECG record files could have one of the following three status: 

- NEW (the record has not been edited and no analysis has been performed and it is 
editable) 

- UNCONFIRMED (the record has been analyzed/edited and is not finalized) 
- CONFIRMED (the record has been finalized, editing is no longer allowed) 

 
To mark a record as CONFIRMED, select the Confirm Record entry in CER-S File menu. 
To mark a record from CONFIRMED to UNCONFIRMED, select the Unconfirm Record entry 
in the File menu. 

 Analysis status 

The analysis status gives information about the analysis/review performed on each ECG 
record and it is displayed in the CER-S status bar. 
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Figure 8 – Example of status bar: the status is UNCONFIRMED, the original annotations have been edited, 
Rhythm Analysis and Beat Measures analysis have been performed 

 
The possible analysis status are: 

- O: original beat annotations loaded from the original record file) 
- Oe: original beats annotations edited 
- BD: beat detection has been performed, beat annotations are detected by ABILE 

algorithm, see section 3.20 
- BDe: Beat Detection performed and beat annotations edited 
- RA: Rhythm Analysis performed, see section 3.20.2 
- RAe: Rhythm Analysis performed and rhythm annotations edited 
- RA(obs): Rhythm Analysis performed, but some modification affected the analysis, it 

is obsolete and should be re-launched  
- B2B: Beat Measures Analysis has been performed, see section 3.21 
- B2Be: Beat Measures Analysis has been performed and families’ measures edited, 

see section 3.21.3 
- B2B(obs): Beat Measures Analysis performed, but some modification affected the 

analysis and some families should be re-analyzed 
- T: templates generated by “Templates Generator”, see section 3.22. 
- MD: Multiday analysis has been performed 
- MDe: Multiday analysis performed and some editing has been performed 

 
The full status is divided in three groups, separated by the character “|”. 
First group is O, BD or MD with "e" and "T" possible suffixes. 
Second group can be missing or RA, with "e" and "(obs)" possible suffixes. 
Third group can be missing or B2B, with "e" and "(obs)" possible suffixes. 
 

 Adding removing record details 

It is possible to customize  the columns available in the recording manager by clicking the 
secondary mouse button on any column’s header and then specifying for each entry if it 
must be visible or hidden; the order of the columns can also be modified, by selecting a 
entry and then clicking on “UP”, “DW” buttons. 
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Figure 9 – Editing of displayed column-details in the Recording Manager 

 

 Continuous ECG Viewer  

Depending on the licensed CER-S configuration this module may not be available. 
 
Continuous ECG Viewer allows to display ECG waveforms and, in case they are present, 
visualize ECG annotations. There are two kinds of ECG annotations that can be visualized: 
 

• ECG beat annotations 
• Window area annotations 

 
The Window area annotations can either be Timepoint Windows or Analysis Windows related 
to the aECG Continuous ECG generation, Noise Regions and Rhythm Annotations Windows 
related to Rhythm Annotation editing. 
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Figure 10 – CER-S display, with continuous ECG recording displayed in the Continuous ECG Viewer, with 12 x 

1 layout 

 
 

 
Figure 11 – ECG beat annotations highlighted in Continuous ECG Viewer, with vertical marker 

 

 ECG beat annotations 

If the loaded Continuous ECG recording include ECG beat annotations, the annotations will 
be displayed in the annotation file. It is important to note that ECG beat annotations will 
only be loaded if the annotation file has the same filename as the Continuous ECG recording 
file and both the files reside in the same folder. 
For ISHNE format, CER-S supports ECG beat annotations in both textual (.txt file extension) 
and binary (.ann extension) format. 
ECG beat annotations for HL7 FDA XML v. 2 are typically stored in an external file but can 
occasionally be encoded within the XML itself. 
Refer to Figure 10 and Figure 11 for examples of ECG beat annotations display. 
 
In case Beat Detection/Editing has been performed and the current session has been saved 
(see section 3.24 for details), beat information will be automatically loaded from the “ACEA” 
session binary file stored in the same folder as the Holter record. 
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Beat information from the session file will override those from the standard annotation file. 
 

 Window area annotations 

If Timepoint Windows or Analysis Windows have been loaded in CER-S, the Continuous ECG 
Viewer displays the sections of the record belonging to the related window 
shaded/highlighted in two different levels of green color. See Figure 12 for an example. 
 

 
Figure 12 – Continuous ECG Viewer showing a Timepoint window and two Analysis Windows 

 
Similarly, Rhythm annotations detected by the algorithm, manually entered via Rhythm & 
Beat editor or loaded from an “ACEA” file are displayed in red (Figure 13). 
 
All colors can be changed in the Display Options dialog box, refer to section 3.29.1 for 
details. 
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Figure 13 – Continuous ECG Viewer, displaying a Rhythm annotation 

 
When moving the mouse over an ECG beat, a gray rectangle is drawn, and the following 
tooltip is displayed if available (see Figure 14): 

• Beat type 
• Template ID it belongs to, with the overall number of beats of the Template 
• Date/time  
• RR and HR 

 
Similarly, when moving the mouse over a Rhythm Annotation, the tooltip shown in Figure 
15 is visualized. 
 

        
Figure 14 – Example of tooltips on an ECG Beat displayed in the Continuous ECG Viewer. The first one is 
related to ECG beat annotations loaded from an external file. The second one was detected by the Beat 

Detector, thus reporting the Template ID and HR 
 

 
 

 
Figure 15 – Example of tooltip on Rhythm Annotation displaying the annotation type, time occurrence and 

related RR and HR 

 

 ECG Beat Interaction 

 
Clicking the primary mouse-button on a single beat, the context menu is displayed where it 
is possible to: 
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• select the related template. 
• select the ECG strip for report 

o in this case an ECG strip of 7s length centered on the selected beat will be 
flagged to be included in the report. The user can then edit the default strip 
label, the beat label, select the desired layout between 12 Leads and 3 Leads 
(II, V2 and V5) and increase the strip length. 

 

 
Figure 16 – “Strip Details” dialog allowing to edit a Strip label and select the strip layout 

 
 

• “Center this point”: make the selected point as the central point of the current view. 
In case of multiline, the selected point will be the center of the 2nd row (in case of 4 
lines) or the center of the 5th row (in case of 10 lines). 
 

 
Figure 17 – the “Central point” of the strip is marked with a vertical grey dashed line 

 



AMPS-TD-RD-UM-Electra_320 v01 Electra_320 User Manual 

 

 
Property of AMPS llc - Company Confidential Page 18 of 174 

 

 Annotation Interaction 

 
Clicking the primary mouse-button on a window area annotation, the context menu is 
displayed where it is possible to: 
 

  
 

• Display the beginning or end of the selected event in case it is not fully visualized 
• select the ECG strip for report 

o in this case an ECG strip of 7s length (or multiple of 7s, in case an annotation 
longer than 7s is selected) centered on the selected annotation will be flagged 
to be included in the report. In case of an annotation longer than 42s, the 
strip will be truncated to a length of 42s. The user can then edit the default 
strip label, the annotation type, edit the desired layout between 12, 3 Leads 
(II, V2 and V5) and miniature (only in case an annotation longer than 7s is 
selected) and edit the strip length. 

 

 
Figure 18 – “Strip Details” dialog for window area annotation 

 
 

• “Center this point”: make the selected point as the central point of the current view. 
In case of multiline, the selected point will be the center of the 2nd row (in case of 4 
lines) or the center of the 5th row (in case of 10 lines). 

 

 Display Configuration 

In the Continuous ECG Viewer, the user can customize the visualization of the ECG by 
adjusting the various parameters via the toolbar buttons or drop-down menu entries.  
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To modify the grid display and layout and to change the color of the ECG waveforms and 
the various annotations, refer to the Display Options on section 3.29.1. 
 
Information regarding the continuous ECG time and current position, with millisecond 
precision, are displayed in the status bar at the bottom of the Continuous ECG Viewer. In 
the following example, the continuous ECG starts at 7:43:00 and has a length of 23 hours 
and 38 minutes. The selected time (i.e. the central time displayed in Figure 17) of the 
displayed ECG signal is 14:21:07. 
 

 
 

The end of the recording is available on the tooltip when the mouse cursor is on the first 
field. 
 
The ECG waveforms can be scrolled using the horizontal scroll-bar at the bottom of the 
Viewer. While scrolling, a tool-tip indicates the current position within the ECG with a millisec 
precision. In case of a record longer than 24 hours, the tooltip will also indicate the day of 
recording. 
 

    
 

By clicking on the button  next to the horizontal scroll-bar, it is also possible to slightly 
scroll the current page backwards to the whole second (i.e. .000 ms). 
 

The scrolling buttons  and  allow to scroll the ECG signal backward and forward 
respectively, by one tenth of the displayed time amount. Scrolling buttons  and  allow 
to scroll the ECG signal backward and forward respectively by the width of the displayed 
window. 
 

3.4.5.1. Multiline Display 

 
Standard / Multilines ECG waveform display can be toggled using the second toolbar button 
from the left. The former allows for a more detailed ECG waveform display, with the latter 
display it is possible to display long portion of signal, up to 30 minutes, on a maximum of 3 
leds. 
By clicking the secondary mouse button on the lead label, it is possible to change the leads 
to be displayed both on Standard / Multilines display. 
 
“Standard” and “Multilines” displays are independent and can be differently customized. It 
is thus possible have different display layouts and different lead orders. 
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Examples of “Multilines” display are shown in Figure 12 and Figure 13. 
 

3.4.5.2. Lead display customization 

 
The number of leads to display in the Viewer can be configured by selecting the appropriate 
entry from the leftmost drop-down menu. Selecting the entry “Multilines”, it is possible to 
display the ECG signal in multiple lines. The maximum number of leads in multiple lines is 
three.  
In case “Multilines” leads to be displayed are modified, this will not affect the “standard” 
display. 
 

3.4.5.3. Time Display Customization 

 
The number of seconds to display in the Viewer can be configured by selecting the desired 
interval from the second drop-down menu from the left. 
In case of “Standard” display, available time durations are: 5, 10, 20, 30, 60 and 120 
seconds. If the selected length is greater or equal than 60 seconds, a dot is displayed instead 
of the beat’s label. 
In case of “Multilines” display, available time durations are: 40, 60, 120, 180, 240, 300, 360, 
600, 1200 and 1800 seconds. If the selected length is greater or equal than 60 seconds, a 
dot is displayed instead of the beat’s label. 
 

3.4.5.4. Voltage Display Customization 

 
The amplitude resolution to display in the Viewer can be configured by selecting the desired 
resolution from the third drop-down menu from the left. 
Available voltage resolutions are between 1 and 8 mV. 
 

3.4.5.5. Superimposition Display 

 
Standard/superimposed ECG waveform display can be toggled using the first toolbar button 
from the left. 
Shown below is an example of Superimposed ECG waveforms. 
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Figure 19 – Example of ECG waveforms drawn in Superimposed mode in Continuous ECG Viewer 

 

 ECG Calipers 

 
Time (i.e. duration) and Voltage (i.e. amplitude) can be manually measured with the two 
available manual calipers. 
Calipers can be moved around the screen and their length adjusted for correct 
measurements.  
 

 
Figure 20 – Example of horizontal time-caliper to manually measure the time intervals 

 

 Change displayed leads 

 
The current selection (single/multiple beats, noise regions or rhythm annotations) in the 
Continuous ECG Viewer can be reset using the fifth toolbar button from the left. 
 

 Reset Current Selection  
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The current selection (single/multiple beats, noise regions or rhythm annotations) in the 
Continuous ECG Viewer can be reset using the fifth toolbar button from the left. 
 

 Navigation 

When multiple ECG beats, Noise Regions or Rhythm annotations are selected via one of the 
available “navigation” modules (Annotations Summary, Histograms, Tables, Templates or 
Trends) in the Continuous ECG Viewer, it is possible to navigate within the selection. Namely 
it is possible to display the previous/next of first/last item via dedicated toolbar buttons. 
The button at the center displays the current item in case of manually scrolling of the display. 
 

 
 

Information regarding the display of the selected beats is displayed in the status bar at the 
bottom of the Continuous ECG Viewer as shown below, indicating that the 7th ECG beat is 
displayed, selected from the Time Trend display.  
 

 
 

 

 Edit Settings 

 
Clicking on the “Edit Settings” button, the “Continuous ECG Viewer Settings” dialog is 
opened. 
In the “RR visualization” panel, the user can decide whether to visualize the RR interval on 
the ECG signal.  
RR display is automatically disabled if this would overlap with the beat label. 
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In the “Current Item” panel, the user can choose if the current item (ECG beat, Rhythm 
annotations or Noise Region) shall always be centered in the Continuous ECG Viewer or 
not. In the latter case, if more than one item is available in the displayed portion of ECG 
signal, the signal will not be shifted. 
 
In the “Review Modes” panel, the user can choose to activate two modalities of review 

• Rhythm annotations & Beat Review 
• Template Review, by mimicking template layout 

 
The former allows the simplification of events display of Continuous ECG Viewer in case of 
selection of ECG Beats, Rhythm annotation events and HR events, as described in section 

3.4.13 and it can be activated with the toolbar button . 
The latter is designed for the review of ECG beats within templates with a zoomed and 
optimized display layout, namely the Continuous ECG Viewer will be forced to display the 
leads available in the templates (in the same order) in single-line fashion, with a layout of 
2 seconds and 2 mV resolution. 
The user can then modify the layout, and these settings will be saved for future CER-S 

sessions; refer to section 3.4.14 and it can be activated with the toolbar button . 
 
In the “Context View” panel, it is possible to enable/disable the context view and configure 
several parameters, namely: 

• the number of seconds displayed in the context view. 
• the resolution in mV of the ECG displayed in the context view. 
• the leads to visualize in the context view. 

The context view is available only in “Single Line mode”. In “Multiline”, it is automatically 
disabled. 
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The context view shows a portion of the Holter which contains the displayed ECG, 
highlighted with a gray rectangle (see Figure 21).  
 

 

 
Figure 21 – Example of a 3 lead 120 seconds long context view, the ECG displayed above is highlighted with 

a grey rectangle 
 

The interactive context view allows for changing the displayed ECG’s position by dragging 
the gray rectangle. 
 

 Review of ECG Strips for Printing  

 
Clicking on the “View Selected Strips” button from the Continuous ECG Viewer toolbar allows 
ECG Strips (both automatically and manually selected) to be reviewed and enables the user 
to: 

• review the Strip 
• modify the Strip layout, between 3 and 12 leads (if a continuous ECG recording with 

more than 3 leads is displayed) or miniature 
• delete one or more strips 
• change the Strip label 
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Figure 22 – “Strips Details” dialog, allowing to edit Strip label (preset to the Rhythm Annotation type) and 

select the strip layout for all pre-selected Strips 

 

3.4.11.1. Review of ECG Strips for Printing in case of Multiday analysis 

In case of Multiday analysis, the “View Selected Strips” button from the Continuous ECG 
Viewer toolbar only allows to review manually selected ECG Strips, as automatic ECG strips 
are reidentified at the end of the process on the current events, precisely at the time of 
printing the report. 
 

 Hide Rhythm annotation 

 
Clicking this button allows simplification of the display of Continuous ECG Viewer, by 
hiding the visualization of RR intervals, beat detection positions and rhythm annotations 
not manually insertable, namely: 

• Bradycardia 
• Pause 
• Prolonged RR Interval 

• Supraventricular Tachycardia 
• Isolated Supraventricular Beat 
• Supraventricular Couplet 
• Supraventricular Run 
• Supraventricular Bigeminy 

• Supraventricular Trigeminy 
• Ventricular Tachycardia 
• Isolated Ventricular Beat 
• Ventricular Couplet 
• Ventricular Run 

• Ventricular Bigeminy 
• Ventricular Trigeminy 
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 Events & Beats Review mode  

 
Clicking this button allows to activate the Rhythm annotations & Beat Review mode that 
simplifies the events display of Continuous ECG Viewer in case of selection of ECG Beats, 
Rhythm annotation events and HR events. 
Here the list of Continuous ECG Viewer display modification in the various selections: 

• ECG Beats 
o Only beats and noise regions are displayed, while rhythm annotation and HR 

events are hidden 
• Rhythm annotations 

o Only beats, noise regions and selected rhythm annotation type are displayed, 
while the other rhythm annotation types and HR events are hidden 

o ECG beats cannot be selected, gray rectangles are hidden 
• HR events 

o Only beats, noise regions and HR events are displayed, while all rhythm 
annotation are hidden 

o ECG beats cannot be selected, gray rectangles are hidden 
 
Events & Beats Review mode can also be activated in the Continuous ECG Viewer settings 
(section 3.4.10), by enabling the related check-box. 
 

 
 

As Rhythm annotations & Beat Review mode deeply simplifies the events display, visualizing 
only certain ECG annotations or ECG Beats, the cardiologist may be induced to erroneously 
fail to assess all the events.  
 
If Rhythm annotations Review mode is active, selection and editing of ECG beats is disabled. 

 Mimic Template Layout  

 
Clicking this button allows to activate mimic template display in the Continuous ECG 
Viewer and it is designed for the review of ECG beats within templates in a zoomed and 
optimized display. 
Continuous ECG Viewer will be forced to display the leads available in the templates (in 
the same order) in single-line fashion, with a layout of 2 seconds and 2 mV resolution. 
The user can then modify the layout, and these settings will be saved for future CER-S 
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Figure 23 – “Mimic Template Layout” feature for optimized review of ECG beats within templates 

 

 Edit Menu - Undo Option 

Selecting “Undo” entry from “Edit” Menu on the top left or clicking the  toolbar button, 
it is possible to erase the last performed change, thus reverting to the previous state. 
Note that an erased change cannot be automatically “re-done”.  
 

 
Figure 24 – “Edit” Menu 

 Display Menu - General Display Configuration 

 
Display configurations are available from the Display Menu. 
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3.6.1.1. Correct Vertical Shift (CVS)  

Continuous ECG recordings often present large baseline wandering, sometimes getting so 
large that the offset may cause certain leads not to be displayed in standard layout. 
For this reason, a wandering-removal option have been added (being active by default) that 
would vertically re-align the leads, removing the vertical shift.  
Vertical shift can be enabled by selecting the Correct Vertical Shift entry from the Display 
Menu. 

 
If the Correct Vertical Shift option is enabled, this is reported on the right side of the 
status bar of the Continuous ECG Viewer or Rhythm & Beat Editor Viewer with the CVS 
code. 

 

 
 

3.6.1.2. Low Pass Filter (LPF) 

Continuous ECG recordings often present high frequency noise due to muscle activity and 
electrical interference. 
For this reason, we have added a filtering option that removes the noise component by low-
pass filtering the ECG signals with a cut-off of 60 Hz. 
Low Pass filtering can be enabled by selecting “Apply Low Pass Filter” entry after clicking 
the Display Menu on the top left.  

 
If the “Apply Low Pass Filter” is enabled, this is reported on the right side of the status bar 
of the Continuous ECG Viewer, with the LPF code. 

 

 
 

3.6.1.3. Invert Leads (LPF) 

It may occur that one or more leads are acquired with inverted polarity. To overcome this 
effect, we have added an option that allows the users to invert one or more leads. This 
option can be enabled by selecting the “Invert Leads” entry from the Display Menu on the 
top left, by selecting which the leads shall be inverted.  

 

 
 

If the “Invert Leads” is enabled, this is reported on the status bar of the Continuous ECG 
Viewer by the code INL. 
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3.6.1.4. Panels Layout 

The graphical display is always divided in two panels: LEFT and RIGHT displays. 
It is possible to change the size of each display using the mouse in a click-and-drag fashion 
over the vertical separator.  

To minimize/restore the LEFT display, the user can click on the  /  icons. 
To maximize/restore the RIGHT display, the user can click on the  /  icons. 
 
The LEFT display can be dragged and docked on right, top and bottom. 
To restore the default layout, select Restore Panels Layout entry from Display menu. 
To switch between left/right and top/bottom layout, select the Invert Panels Position entry, 
while to switch the panels (left to right or top to bottom and vice versa), select Switch Panels 
entry. 

 Rhythm & Beat Editor Viewer 

 
The Rhythm & Beat Editor Viewer is an enhanced Continuous ECG Viewer that shares the 
very same display features and, in addition, allows the interaction with the ECG tracing. 
It is thus possible to select one or more ECG beats and change their beat annotation label, 
modify the detection point of an ECG beat or to manually enter or delete Noise Regions or 
Rhythm Annotations. 
 
For the various annotation display features, refer to sections 3.4.1 to 3.4.4 of the Continuous 
ECG Viewer. For the “Display Configuration” refer to section 3.4.5, starting on page 18. 
 
In Rhythm & Beat Editor, all major actions that can be performed with the mouse are also 
accessible by the keyboard. To configure keyboard key combination, refer to section 3.29.4, 
on page 161. 
 
In Rhythm & Beat Editor Viewer a beat attractor, in green color, allows to perform an action 
on a single beat or on a multiple beat selection. 
 
If Beat editing is performed after Rhythm analysis has run, there could be erroneous Rhythm 
annotations still visualized. 
 

 Beat & Rhythm Editing 

3.7.1.1. Editing on single ECG beat 

By clicking the primary mouse-button on a single beat, the context menu (Figure 25) is 
displayed where it is possible to: 
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Figure 25 – Context Menu for primary-mouse click on a single ECG beat 

 
• show the template related to the selected ECG beat 
• select the ECG strip for report 

o in this case an ECG strip of 7s length centered on the selected beat will be 
flagged to be included in the report. The user can then edit the default strip 
label, the beat label, select the desired layout between 12 Leads and 3 Leads 
(II, V2 and V5) and, if needed, increase the strip length. 

 

 
 

 
• Center the current view to the selected beat’s position, selecting the “Center this 

point” entry. 
 

Clicking the secondary mouse-button on a single beat, it is possible to: 
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• adjust the beat detection position, selecting the “Adjust Detection Position” entry. 
The “Adjust Detection Position” dialog is prompted where the beat detection position 
can be edited as shown in Figure 26. In the dialog box, it is also possible to adjust the 
display organization for a more precise caliper editing, but the default is the very same 
display layout than the Continuous ECG Viewer or Rhythm & Beat Editor. 

 

  
Figure 26 – Manual adjustment of single ECG beat detection position 

 
 

• modify selected beat label 
o the list of available beat categories is displayed (Figure 27), these being: 

▪ N – Normal Beat 
▪ V – Ventricular Beat 
▪ S – Supraventricular Beat 
▪ C – Calibration Pulse 
▪ B – Beat with Bundle Branch Block 
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▪ P – Paced Beat 
▪ E – Ventricular Escape Beat 
▪ F – Fusion Beat 
▪ U – Unknown Beat 
▪ X – Artifact 

 

 
Figure 27 – Context Menu to modify the ECG beat label 

 
• delete selected beat 
• add Noise Region (a noise region will be entered, centered on the selected beat and 

extended in both right and left direction to the first valid beat) 
• Add a Noise Region starting from the beginning of the ECG recording to the selected 

beat’s position 
• add a Noise Region starting from the selected beat and ending at the end of the ECG 

recording, to be used in case leads are detached while the recording is still ongoing 
• add Noise region by selecting the onset and afterward selecting the offset (or 

resetting the noise region addition), via context menu displayed upon clicking the 
secondary mouse-button on a beat. The option of resetting the previously entered 
noise onset is also available. 

 

 
 

• set the start point of a new rhythm annotation selecting the “Set Rhythm Annotation 
onset” entry and selecting the related annotation between those that can be manually 
entered, namely: 

o Atrial Fibrillation 
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o Atrial Flutter 
o Atrial Tachycardia 
o Ventricular Fibrillation 
o Ventricular Flutter 
o Torsade de Pointes 

 

 
 

Then the user will have to select the offset of the Rhythm annotation, as reported 
here below where Atrial Fibrillation onset had been previously selected. The option 
of resetting the previously entered onset is also available. 

 
 

 
 

• set the start point of an AtrioVentricular Block annotation selecting the “Set AV Block 
onset” entry and selecting the correct entry between: 

o First-degree Atrioventricular Block 
o Type 1 Second-degree Atrioventricular Block 
o Type 2 Second-degree Atrioventricular Block 
o Third-degree Atrioventricular Block 
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Then the user will have to select the offset of the atrioventricular block. The option 
of resetting the previously entered AVB onset is also available. 
 

 
 

 

3.7.1.2. Editing on the ECG signal & Entering a New ECG Beat 

By clicking the primary mouse-button on the ECG signal (with a certain distance from an 
existing ECG beat), the following context menu is displayed where it is possible to: 
 

 
 

• select the ECG strip for report 
o in this case an ECG strip of 7s length centered on the selected beat will be 

flagged to be included in the report. The user can then enter a strip label, 
select the desired layout between 12 Leads and 3 Leads (II, V2 and V5) and, 
if needed, increase the strip length. 

 
 



AMPS-TD-RD-UM-Electra_320 v01 Electra_320 User Manual 

 

 
Property of AMPS llc - Company Confidential Page 35 of 174 

 

 
 
• Center the current view to the selected beat’s position, selecting the “Center this 

point” entry. 
 
 
Clicking the secondary mouse-button on the ECG signal (with a certain distance from an 
existing ECG beat), the following context menu is displayed where it is possible to: 
 

• add a new ECG beat with a given label 
o the list of available beat categories is displayed (Figure 27), these being: 

▪ N – Normal Beat 
▪ V – Ventricular Beat 
▪ S – Supraventricular Beat 
▪ C – Calibration Pulse 
▪ B – Beat with Bundle Branch Block 
▪ P – Paced Beat 
▪ E – Ventricular Escape Beat 
▪ F – Fusion Beat 
▪ U – Unknown Beat 
▪ X – Artifact 
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• add a Noise Region starting at the beginning of the ECG recording to the selected 
position 

• add a Noise Region starting at the selected position and ending at the end of the ECG 
recording 

• add Noise region by selecting the onset and afterward selecting the offset (or 
resetting the noise region addition), via context menu displayed upon clicking the 
secondary mouse-button anywhere on the ECG signal. The option of resetting the 
noise previously entered onset is also available. 
 

 
 

• set the start point of a new rhythm annotation selecting the “Set Rhythm Annotation 
onset” entry and selecting the related annotation between those that can be manually 
entered, namely: 

o Atrial Fibrillation 
o Atrial Flutter 
o Atrial Tachycardia 
o Ventricular Fibrillation 
o Ventricular Flutter 
o Torsade de Pointes 

 

 
 

Then the user will have to select the offset of the Rhythm annotation, as reported 
here below where Atrial Flutter onset had been previously selected. The option of 
resetting the previously entered onset is also available. 
 

 
 

 
• set the start point of an AV Block annotation selecting the “Set AV Block onset” entry 

and selecting the correct entry between: 
o First-degree Atrioventricular Block 
o Type 1 Second-degree Atrioventricular Block 
o Type 2 Second-degree Atrioventricular Block 
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o Third-degree Atrioventricular Block 
 

 
 

Then the user will have to select the offset of the atrioventricular block. The option 
of resetting the previously entered AVB onset is also available. 
 

 
 

3.7.1.3. Editing a contiguous selection of ECG Beats 

 
Selecting a contiguous group of ECG beats with the primary mouse-button, the following 
context menu (Figure 28) is displayed, where it is possible to: 
 

  
Figure 28 – Context Menu for a selection of multiple contiguous ECG beats. On the top of the menu are 
reported the information about the selection such as the duration of the selection, the number of the 

involved beats and the heart rate 

 
• modify the label of the selected beats 

o the list of available beat categories: the same as the one for single-beat 
editing, displayed in Figure 27, on page 32. 

• delete selected beats 
• add Noise Region on the selected beats 
• add a Rhythm Annotation 

o the rhythm annotations that can be manually added are: 
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▪ Atrial Fibrillation 
▪ Atrial Flutter 
▪ Atrial Tachycardia 
▪ Ventricular Fibrillation 
▪ Ventricular Flutter 
▪ Torsade de Pointes 

 

  
Figure 29 – Context Menu for manual insertion of Rhythm Annotations 

 
• add an Atrioventricular Block annotation between: 

o First-degree Atrioventricular Block 
o Type 1 Second-degree Atrioventricular Block 
o Type 2 Second-degree Atrioventricular Block 
o Third-degree Atrioventricular Block 

 
• select the ECG strip for report 

o in this case an ECG strip of 7s length (or multiple of 7s, in case an annotation 
longer than 7s is selected) centered on the selected annotation will be flagged 
for printing. In case of an annotation longer than 42s, the strip will be 
truncated to a length of 42s. The user can then edit the default strip label, the 
annotation type, select the desired layout between 12, 3 Leads (II, V2 and V5) 
and miniature (only in case an annotation longer than 7s is selected) and edit 
the strip length.  

o in this case an ECG strip of 7s length (or multiple of 7s, in case an annotation 
longer than 7s is selected, for a maximum of 42s) centered on the selected 
annotation will be flagged for printing. The User can specify a label for the 
strip, although a default label is predefined, and select the desired layout 
between 12, 3 Leads (II, V2 and V5 in case of 12 lead continuous ECG 
recording) and miniature, in case an annotation longer than 7s is selected, as 
shown in Figure 18. If the selected beat-selection is longer than 14s, the 
default layout will be set to miniature. 

 

3.7.1.4. Selection of noncontiguous ECG Beats 
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It is possible to select noncontiguous ECG beats via primary muse button, keeping the CTRL 
key down. 
 

 
Figure 30 – Context Menu for a selection noncontiguous multiple ECG beats.  

 
Then, by clicking the secondary mouse button it is possible to: 

• modify the label of the selected beats 
o the list of available beat categories: the same as the one for single-beat 

editing, displayed in Figure 27, on page 32. 
• delete selected beats 

 
 

3.7.1.5. Action on Rhythm Annotations 

Clicking the primary mouse-button on a Rhythm annotation, a context menu is displayed 
(as shown in Figure 31), where it is possible to: 
 

• Go to the beginning of the selected Rhythm Annotation (the entry is available only 
when the starting point of the selected annotation is not displayed in the current 
displayed ECG): the current ECG view is scrolled to allow the starting point of the 
selected annotation to be displayed. 

• Go to the end of the selected Rhythm Annotation (the entry is available only when 
the end of the selected annotation is not displayed in the current displayed ECG): the 
current ECG view is scrolled to allow the ending point of the selected annotation to 
be displayed. 
 

  
Figure 31 – Context Menu for actions on a Rhythm Annotation, on primary mouse button click 
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• select the ECG strip for report 

o in this case an ECG strip of 7s length (or multiple of 7s, in case an annotation 
longer than 7s is selected) centered on the selected annotation will be flagged 
to be included in the report. In case of an annotation longer than 42s, the 
strip will be truncated to a length of 42s. The user can then edit the default 
strip label, the annotation type, edit the desired layout between 12, 3 Leads 
(II, V2 and V5) and miniature (only in case an annotation longer than 7s is 
selected) and edit the strip length. 

• center the ECG display to the selected position 
 

 
Figure 32 – “Strip Details” dialog, allowing to edit Strip label (preset to the Rhythm Annotation type), 

select the strip layout and edit the strip length. 

 
If the selected rhythm is longer than 42 seconds and the strip layout is not set to miniature, 
a message box alerting the user of the large selection is shown.  

 

 
 
Clicking the secondary mouse-button on a Rhythm annotation, a context menu is displayed 
where it is possible to (refer to section 3.7.1.2 for more details): 

• delete selected Rhythm Annotation 
• rename ATA Rhythm Annotation (Atrial Fibrillation, Atrial Flutter and Atrial 

Tachycardia) to another ATA annotation 
• add a new ECG beat with a given label 
• add a Noise Region starting at the beginning of the ECG recording to the selected 

position 
• add a Noise Region starting at the selected position and ending at the end of the ECG 

recording 
• set the start point of a Noise region by selecting the “Set Noise Region onset” entry 
• set the start point of a new rhythm annotation selecting the “Set Rhythm Annotation 

onset” entry 
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• set the start point of an AV Block annotation selecting the “Set AV Block onset” entry 
 
 

 
Figure 33 – Context Menu for actions on a Rhythm Annotation, on secondary mouse button click 

 

3.7.1.5.1. Manipulation of Rhythm Annotations 

It is possible to reduce or widen a rhythm annotation clicking and dragging the primary 
mouse-button on a selection of ECG beats. 

• To widen a rhythm annotation, the selection must start from the first (or the last) 
beat of the annotation and end outside it (as shown in Figure 34). In this case, the 
context menu provides the option to widen the annotation. Similarly it is possible to 
make a selection starting outside the annotation and end on the first (or the last) 
beat of the annotation. 

 

 
Figure 34 – Selection of beats which enable the “Widen Rhythm Annotation” entry in the context 

menu 
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• To reduce a rhythm annotation, the selection must be entirely within the annotation 

itself (as shown in Figure 35). In this case the context menu presents an option to 
remove a section of the annotation.  
 

 
Figure 35 – Selection of beats which enable the “Remove Section of Rhythm Annotation” entry in 

the context menu 

 
The rhythm annotations which can be widened or reduced is limited to those that can 
be manually added : 

o Atrial Fibrillation 
o Atrial Flutter 
o Atrial Tachycardia 
o Ventricular Fibrillation 
o Ventricular Flutter 
o Torsade de Pointes 

 

3.7.1.6. Action on Noise Regions 

Clicking the primary mouse-button on a Noise Region, a context menu is displayed enabling 
to: 

• Go to the beginning of the Noise Region (the entry is available only when the starting 
point of the selected region is not displayed in the current displayed ECG) 

• Go to the end of the selected Noise Region (the entry is available only when the end 
of the selected region is not displayed in the current displayed ECG) 
 

  
 
• select the noise region for report 

o in this case an ECG strip of 7s length (or multiple of 7s, in case a noise region 
longer than 7s is selected) centered on the selection point will be flagged to 
be included in the report. In case of an annotation longer than 42s, the strip 
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will be truncated to a length of 42s. The user can then edit the default strip 
label, the annotation type, edit the desired layout between 12, 3 Leads (II, V2 
and V5) and miniature (only in case an annotation longer than 7s is selected) 
and edit the strip length. 

• center the ECG display to the selected position 
 
Clicking the secondary mouse-button on a Noise Region, a context menu is displayed 
allowing, among other things, to delete it. 
 

 
 

 Edited status 

 
When beat detection is performed, the change of status is reported in CER-S status bar as 
“BD”. In case modifications are made by the user the new status is reported in CER-S status 
bar “BDe”. 
 
Similary, when rhythm analysis is performed, the change of status is reported in CER-S 
status bar as “RA”. In case a modification made by the user can alter the analysis, a visual 
alert reporting that the analysis could be obsolete (“RA Obsolete”) is displayed on the title 
bar and the new status is reported in CER-S status bar “RA(obs)”, refer to section 3.3.3 for 
all the details on Analysis status.  
 

 
 

When the analysis is obsolete, if the user proceeds in printing the report (see section 3.27), 
a message box is prompted informing the user that rhythm annotations are obsolete and 
providing three options: 

• recompute rhythm analysis before printing the report – clicking YES 

• proceed with printing the report, without recomputing rhythm analysis –NO 
• cancel printing - CANCEL 
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If editing is performed from the original native record annotation, the new status will be 
“Oe”. 
 
Whenever editing is performed, manual modifications are made and not yet saved in the 
ACEA session file, a visual alert ‘*’ is displayed on the title bar, indicating that editing has 
been performed and not yet saved. If the user attempts to close the software or load a new 
record, the following warning message is prompted: 
 

 
 
The visual alert is no longer shown upon saving the ACEA session file. 
 
 

 Edit Settings 

 
Clicking on the “Edit Settings” button, the “Rhythm & Beat Editor Settings” dialog is opened. 
Refer to section 3.4.10 for “Continuous ECG Viewer Settings” which are identical. 
 

 Events & Beats Review mode 

 
Clicking this button allows to activate the Rhythm annotations & Beats Review mode that 
simplifies the events display of Rhythm & Beat Editor in case of selection of ECG Beats, 
Rhythm annotation events and HR events. 
Here the list of Rhythm & Beat Editor display modification in the various selections: 

• ECG Beats 
o beats and noise regions are displayed, while rhythm annotation and HR events 

are hidden 
o Rhythm annotations cannot be entered 

 



AMPS-TD-RD-UM-Electra_320 v01 Electra_320 User Manual 

 

 
Property of AMPS llc - Company Confidential Page 45 of 174 

 

 
 

   
Figure 36 – Context menus in Rhythm & Beat Editor in case of Beats Review mode, by clicking the 
secondary mouse button within two beats (top image), clicking on a beat (bottom left image) and 
selection of contiguous beats (bottom right image) 

 
• Rhythm annotations 

o beats, noise regions and selected rhythm annotation type are displayed, while 
the other rhythm annotation types and HR events are hidden 

o ECG beats cannot be selected, green rectangles are hidden 
▪ Strips cannot be selected for the report 
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Figure 37 – Rhythm & Beat Editor Context menu, in case of Events Review mode, by clicking the 
secondary mouse button anywhere on the display, with Atrial Fibrillation annotations selection 

 
• HR events 

o beats, noise regions and HR events are displayed, while all rhythm annotations 
are hidden 

o ECG beats cannot be selected, green rectangles are hidden 
▪ Strips cannot be selected for the report 

 

 
Figure 38 – Rhythm & Beat Editor Context menu, in case of HR Events Review mode, by clicking 
anywhere on the display, with HR Max event selection 

 
Events & Beats Review mode can also be activated in the Rhythm & Beat Editor settings 
(section 3.4.10), by enabling the related check-box. 
 

 
 
Note that in case of Beats Review mode active, the strip dialog is not prompted upon 
selecting the “Select strip for report entry”, while in case of Rhythm annotations Review 
mode active, as EG beat cannot be selected, ECG strips cannot be enterd. 
 
As Rhythm annotations & Beat Review mode deeply simplifies the events display, visualizing 
only certain ECG annotations or ECG Beats, the cardiologist may be induced to erroneously 
fail to assess all the events.  
 
If Rhythm annotations Review mode is active, selection and editing of ECG beats is disabled. 
 

 RBE in Multiday analysis 

In case of multiday recording, beat information is not reported in the Rhythm & Beat Editor 
and thus it is only possible to enter Rhythm annotation and Noise Regions by specifying the 
event onset and then indicate the offset. 
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By clicking the primary mouse-button, the context menu (Figure 39) is displayed where it is 
possible to:  

 
Figure 39 – Context Menu for primary-mouse click on a multiday recording 

 
• select the ECG strip for report 

o in this case an ECG strip of 7s length centered on the selected point will be 
flagged to be included in the report. The user can then enter a strip label, 
select the desired layout between 12 Leads (in case of a 12 leads recording) 
and 3 Leads (II, V2 and V5 in case of 12 leads recording or the first three 
leads) and increase the strip length. In case the selection length is greater 
than 7s, a miniature layout can also be selected. 

 

 
 

 
• Center the current view to the selected beat’s position, selecting the “Center this 

point” entry. 
 
By clicking the secondary mouse-button, the context menu (Figure 40) is displayed where 
it is only possible to: 

• add a Noise Region starting at the beginning of the ECG recording to the selected 
position 

• add a Noise Region starting at the selected position and ending at the end of the ECG 
recording 

• set the start point of a Noise region by selecting the “Set Noise Region onset” entry 
• set the start point of a new rhythm annotation selecting the “Set Rhythm Annotation 

onset” entry and selecting the related annotation between those that can be manually 
entered case of multiday recording, namely: 

o Pause 
o Ventricular Tachycardia 
o Atrial Fibrillation 
o Atrial Flutter 
o Atrial Tachycardia 
o Ventricular Fibrillation 
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o Ventricular Flutter 
o Torsade de Pointes 

 

 
Figure 40 – Context menu for multiday recordings 

 
 

Then the user will have to select the offset of the Rhythm annotation, as reported 
here below where Atrial Fibrillation onset had been previously selected. The option 
of resetting the previously entered onset is also available. 
 

  
 

 
• set the start point of an AV Block annotation selecting the “Set AV Block onset” entry 

and selecting the correct entry between: 
o First-degree Atrioventricular Block 
o Type 1 Second-degree Atrioventricular Block 
o Type 2 Second-degree Atrioventricular Block 
o Third-degree Atrioventricular Block 

 
• Enter a detailed analysis segment to cut and export in the current position (it will 

then be possible to perform standard Beat Detection and Rhythm analysis and that 
segment on a new CER-S session) 
 

 
 

Here the user will have to specify: 
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o the name of the segment. This label will be placed in the Visit field of the 
exported record segment. In case a Visit label is already present in the current 
multiday continuous ECG recording, the Visit label of the exported record 
segment will be the concatenation of the two, divided by the text “ - “ 

o the length of the segment, between 1 and 24 hours. 
 

• Set the onset of a detailed analysis segment to cut and export. 
Then the user will have to select the offset of the detailed analysis segment and the 
following dialog will be prompted allowing to specify the name of the segment is 
displayed. This label will be placed in the Visit field of the exported record segment. 
In case a Visit label is already present in the current multiday continuous ECG 
recording, the Visit label of the exported record segment will be the concatenation of 
the two, divided by the text “ - “. 

 
 

 
 

 
The maximum length of detailed analysis segment is 24 hours and, in case of the 
segment between onset and offset is longer 24 hours, the following warning message 
will be prompted to inform the user to reduce the selection.  

 

 
 
To export selected detailed analysis segments, select “Cut and Export Record” entry from 
File menu; segments will be exported in AMPS compressed format (ACecg). 
 

3.7.5.1. Events & Beats Review mode   

In case of active Event & Beats Review modality and an active selection of Atrial fibrillation 
events, in addition to the context menu entry described in the previous section, deletion and 
renaming of the Atrial fibrillation event will be available, as shown here below. 
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Figure 41 – Context menu for multiday recordings and active Review event mode 

 

 Analysis Window Viewer  

The software includes a Viewer dedicated to the display of Analysis Windows (AWs): Analysis 
Window Viewer. 
 
This Viewer is active only if: 

• the loaded continuous ECG recording is in FDA HL7 XML v. 2 format and an AW 
element has been selected from the LEFT display Timepoint Window Navigator. 

• the loaded continuous ECG recording is in ISHNE or MIT format, AWs have been 
loaded via the “aECG Generator” menu and an AW element has been selected from 
the LEFT display Timepoint Window Navigator. 

Otherwise the “No AW selected” text will be visualized. 
 

 
Figure 42 – Analysis Window Viewer 12 x 1 display – AW with annotations on lead II 

 
The visualization customization options of the Analysis Window Viewer are mostly identical 
to those of the Continuous ECG Viewer (refer to sections 3.4 starting on page 13, and 
3.4.5.2-3.29.1 for details) apart a few extra features described in the following sections. 
 

 Lead Display Customization – Rhythm Strip 

 



AMPS-TD-RD-UM-Electra_320 v01 Electra_320 User Manual 

 

 
Property of AMPS llc - Company Confidential Page 51 of 174 

 

 
As in the case of Continuous ECG Viewer, the number of leads to be displayed in the Viewer 
can be configured by selecting the desired number from the pull-down menu. In addition to 
the number of leads, there are four additional entries that can be selected, each mimicking 
one of the following standard paper ECG formats:  
 

• 3 x 4: three leads per row in four columns (each lead is displayed for 2.5s), 

• 6 x 2: six leads per row in two columns (each lead is displayed for 5s), 
• 3 x 4 + Long Lead: three leads per row in four columns and long lead, 
• 6 x 2 + Long Lead: six leads per row in two columns and long lead. 
 

In addition to the ECG waveforms, the Analysis Window Viewer may also display annotations 
(if available). 
 
The recording time offset of the leftmost part of the displayed waveforms is shown to the 
left of the scrollbar. If the ECG has not been scrolled, it will indicate “0.00 sec”, as displayed 
in Figure 43. 
 

 
Figure 43 – Analysis Window Viewer 3 x 4 + long lead II display  

 

 ECG Beat Annotation Display 

In the Analysis Window Viewer, the button  allows to toggle on/off the display of the 
ECG measurement annotations. 
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 Representative Beat display 

The  button helps to toggle between the Rhythm and the Representative Beats 
display. 
 

3.8.3.1. Lead Display Customization – Representative Beats 

 

 
The number of leads to be displayed in the Viewer can be configured by selecting the desired 
number from the pull-down menu. In addition to the number of leads, there are four 
additional entries that can be selected, each mimicking one of the following standard paper 
ECG formats:  

• 3 x 4: three leads per row in four columns, 
• 6 x 2: six leads per row in two columns, 
• 3 x 4 + Overlap: three leads per row in four columns and Superimposed display, 
• 6 x 2 + Overlap: six leads per row in two columns and Superimposed display. 

 

 
Figure 44 – Analysis Window Viewer, Representative Beats display in 3 x 4 + Overlap format; annotations 

are available on the Global (SMB) 
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Figure 45 – Analysis Window Viewer, Representative Beats display in 6 x 2 + Overlap format; annotations 

are available on the Global (SMB) 

 
 

 Timepoint Window Navigator  

The software includes a module that allows the navigation of Timepoint Windows and 
Analysis Windows listings: Timepoint Window Navigator. 
 
This module is active only if: 

• the loaded continuous ECG recording is in aECG FDA HL7 XML v. 2 format and it 
contains at least a Timepoint Window or an AW. 

• the loaded continuous ECG recording is in ISHNE or MIT format and at least a 
Timepoint Window or an AW has been loaded via the “aECG Generator” menu. 

 
This module is structured as a tree (see Figure 46), with three levels: 

• first level, identified with the icon  
o provides a summary of the available Timepoint Windows (TPW) and Analysis 

Windows (AW), 
o provides a summary of the available Protocol Events entries 

• second level, identified with the icon  
o indicates a given TPW. Each TPW is identified by its start date/time and the 

duration in minutes, in between round brackets 
o indicates a given Protocol Event with its Label and time 

• third level, identified with the icon , indicates a given AW. Each AW is identified by 
its start date/time and the duration, in seconds, between round brackets. 
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Figure 46 – Timepoint Windows Navigator – example with 3 TPWs and 9 AWs, 3 per TPW and 3 Protocol 

Events 

 
Clicking the first level icon is not linked to any display changes. On the other hand by clicking 
on a TPW icon, the Continuous ECG Viewer or Rhythm & Beat Editor will be synchronized to 
visualize the start time of the selected TPW in the center of the Viewer (refer to Figure 47). 
 
By clicking on a protocol event entry, both the Continuous ECG Viewer and the Rhythm & 
Beat Editor are synchronized to display the event in the center of the Viewer. 
 
By clicking on an AW icon, the Analysis ECG Viewer is displayed, visualizing the selected 
Analysis Window (refer to Figure 48). 
 

 
Figure 47 – Timepoint Windows Navigator – Time synchronization of the Continuous ECG Viewer by clicking 

on a TPW 
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Figure 48 – Timepoint Windows Navigator – Analysis ECG Viewer is displayed by clicking on an AW 

 

 Annotations Summary 

When a continuous ECG recording is loaded along with its ECG beat annotations file or a 
session is restored, the Annotations Summary displays an interactive summary of all the 
ECG Beat annotations, Rhythm and Noise annotations. 
 

 ECG Beat Annotation details 

 
The overall number of ECG Beats and the overall time is reported on top, and then all the 
ECG beat types are reported with their frequency. 
It is then possible to “maximize” each beat type node and see the element-listings 
(date/time of the ECG beat) of all ECG beats belonging to a given classification label. 
 

 
Figure 49 – Annotations Summary – Summary of ECG Beat labels, Noise and Rhythm 

Annotations for a continuous recording 
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In case a node with more than 1’000 beats is selected, a warning message is prompted 
informing the user that expanding such node could take some time.  
 

  
 
The element-listings are interactive. By clicking on a given element, the Continuous ECG 
Viewer or Rhythm & Beat Editor is synchronized to display the first of the selected ECG 
beats, then with the navigation toolbar buttons (refer to section 3.4.9 for more details) or 
the related shortcut key, it is possible to display the other selected beats. 

 
 

  
Figure 50 – Annotations Summary module synchronized with the Rhythm & Beat Editor: a beat selected on 

the Annotations Summary module is shown on the right 

 
Depending on the version of CER-S in use, Rhythm & Beat Editor may be available. In this 
scenario, editing is possible. By clicking the secondary mouse button on an ECG type node, 
a context menu is displayed allowing the deletion of all beats of the selected type or the 
relabeling of all the selected beats. 
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In addition to the ECG beats, if Rhythm Annotation has been computed or loaded, these are 
also reported on the Annotations Summary in the lower part. 
 

 Noise & Rhythm Annotation Details 

The list of Noise Regions and Rhythm Annotations is given here. By selecting an item on the 
Annotations Summary, the selected annotation can be displayed on the Continuous ECG 
Viewer or Rhythm & Beat Editor Viewer, then with the navigation toolbar buttons (refer to 
section 3.4.9 for more details) or the related short cut key, it is possible to display the other 
selected items. 
 

 
Figure 51 – Annotations Summary module synchronized with the Rhythm & Beat Editor Viewer: a 

“Bradycardia” rhythm annotation is selected on the Annotations Summary and it is shown on the right 

 
In case there are one of more Noise Regions, the number of regions with the overall length 
and the percentage against the recording length are reported. 
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When the node is maximized, each single Noise Region is reported with its length and the 
date/time stamp. 
 

 
 
By clicking the secondary mouse button on the main Noise Annotations node, the following 
context menu is displayed allowing: 

• deletion of all Noise regions (only if Rhythm & Beat Editor is available and thus editing 
is allowed). 

• modification of Noise regions order 
o Based on start-time 
o Based on length, longest first 
o Based on length, shortest first 

 

 
 
 
The Annotations Summary, Below the noise information, Rhythm Annotations (with the 
overall number) are listed, grouped on Rhythm Annotation type.  
For the majority of Rhythm Annotations, the reported details are the date/time stamp and 
the duration, as for the Prolonged RR intervals here show. 
 

 
 
For "Bradycardia", "Ventricular Tachycardia" and "Supraventricular Tachycardia" Rhythm 
Annotations, the following details are reported: 

• # of beats 
• shortest RR 
• longest RR 
• average RR 

 
While, for "Ventricular Run" and "Supraventricular Run", the following details are reported: 

• # of beats 
• shortest RR 
• longest RR 
• average RR 

• first RR (N-V or N-S) 
• HR Max 
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Figure 52 – Annotations Summary module reporting the details for a  

Supraventricular Run Rhythm annotation 

 
As for Noise regions, by clicking the secondary mouse button on the main Rhythm 
Annotations node, a context menu is displayed allowing: 

• the deletion of all Rhythm Annotations (if Rhythm & Beat Editor is available and thus 
editing is allowed). 

• the modification of Noise regions order 
o Based on start-time 
o Based on severity 
o Based on length, longest first 
o Based on length, shortest first 

 
The severity of a rhythm annotation change in according to its type: 

- Isolated V/S: RR value - shortest is the most severe 
- S/V couplet: duration - shortest is the most severe 
- S/V Run: # of beats - longest is the most severe 
- Sup./Vent. Tachycardia: mean RR - lowest (fastest Tachycardia) is the most severe 
- Bradycardia: mean RR - longest (slowest Bradycardia) is the most severe 
- Prol. RR, Pause, S/V Bigeminy and Trigeminy, AFib: duration - longest is the most 

severe 
 

 
 
By clicking the secondary mouse button on a Rhythm Annotation node of a given type, a 
context menu is displayed allowing the deletion of all Rhythm Annotations of the selected 
type. 
 
When an annotation type node is maximized, it is possible to display any annotation by 
clicking directly on the node. It is possible to select more than one annotation node, clicking 
the mouse button with the CTRL keyboard key pressed.  
Similarly, it is possible to make a contiguous selection of annotations, by clicking on the first 
item and on the last, keeping the SHIFT keyboard key pressed. 
By clicking the secondary mouse button on the selection is then possible to delete all the 
selected items. 
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Figure 53 – Event selection with the use of CTRL (on the left) and SHIFT keyboard keys (on the left) 

 
It is possible to customize the action performed when deleting rhythm annotations.  
By default, a noise region is added replacing the deleted annotation and this configuration 
shall the preferred one. 
Differently it is possible to remove the event and automatically relabel the underlying ECG 
beats. This feature only occurs on VT and SVT Isolated/Couplets/Run and Tachycardia 
events. 
Last it is possible to delete the event without any additional action. 
This selection can be done in the upper section of the Data Editing Options dialog, displayed 
by selecting Editing Settings entry from the Options menu, see Figure 54. 
 

 
Figure 54 – Data Editing Options allowing the selection of the action to be performed when deleting rhythm 

annotations or HR events. 

 

 HR and HR Events 

In CER-S software, Heart-Rate is computed for all ECG beats using a 10s window prior the 
ECG beat location and can be computed in two different ways:  

• using all available beats 
• excluding V beats 
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The HR computation strategy can be configured in the lower section of the Data Editing 
Options dialog, displayed by selecting Editing Settings entry from the Options menu, see 
Figure 54. 
 
In the node HR Events are reported special heart rate related events, namely minimum and 
maximum RR and heart rate. 
These events are automatically computed when loading a recording or when editing is 
performed. 
The interaction with these nodes allows for a quick identification of namely minimum and 
maximum RR and heart rate throughout the recording. 
 
Similarly to standard Rhythm annotations, also for HR events it is possible to customize the 
action performed when deleting an event.  
By default, a noise region is added replacing the deleted annotation and this configuration 
is to be generally used. 
Differently it is possible to delete the event without any addition of noise. In case this latter 
option is selected, HR events review shall be performed at the very end of the analysis 
process, otherwise, in case of beat or rhythm annotation editing is performed after HR 
events editing, inconsistencies between Table and Annotation Summary may be present. 
 
This selection can be done in the lower section of the Data Editing Options dialog, displayed 
by selecting Editing Settings entry from the Options menu, see Figure 54. 
 

 Trends Display 

This advanced interactive display allows ECG beat information to be visualized as “RR vs 
Time” or “Poincaré” display (RR vs RR + x), in a X/Y dot-plot, where each dot represents an 
ECG beat. Beats labeled as C or X are not shown in this graph. 
 
This display is not available in case of Multiday recordings. 
 
It is possible to select one or more beats and review them in the Rhythm & Beat Editor or 
in case this is missing, in the Continuous ECG Viewer. The selection can be performed with 

a rectangular shape (selecting the  icon) or freehand ( ) drawn, as shown here 
below. 
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Figure 55 – Selection of ECG beats in the Trends display, with Freehand (left)  

and Rectangular selection (right) 
 

The trend display is interactive: selecting one or multiple dots, the Continuous ECG Viewer 
or the Rhythm & Beat Editor Viewer is updated to show the first beat of the selection (Figure 
56). 
In Continuous ECG Viewer or Rhythm & Beat Editor, it is possible to navigate through the 
selected ECG beats using the navigation button as described in section 3.4.9. 
 

 
Figure 56 – Selection of ECG beats in the Trends display synchronized with the Beat Editor Viewer 
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Clicking the  icon, it is possible to reset the current selection by clicking the  
button from Continuous ECG Viewer or Rhythm & Beat Editor toolbar. 

Clicking the  icon, it is possible to invert the current selection (select the unselected 
beats). 
Clicking the  /  buttons, it is possible to hide/show all the Trends buttons and settings, 
and thus maximize the size of the graphs. 
 
In case of time trends (where time is selected on the X axis), two additional buttons are 
available to: 

- Display/hide the mean RR/HR trends, with the button  
o If the mean RR/HR is displayed, it is possible to hide/show the ECG beat-dots 

from the graph, with the button   

- Zoom the tachogram (time RR display) with the button , enabling/disabling the 
time-scrolling of the displayed trend. Here the entire trend is displayed on the lower 
portion, while on the upper one, the zoomed trends is displayed. 
It is possible to scroll in time with the horizontal scrollbar, with the yellow arrows or 
by clicking and dragging the grayed area of the lower display.  
Scrolling options are described in the ‘advanced’ section of the Options dialog box, 
refer to section 3.11.2. 
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Figure 57 – Trends display with Zoom feature active with zoomed resolution of the upper display set to 60 

minutes 

 
In the “Axis” section, it’s possible to configure the ECG beat information to display. 
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The leftmost drop-down menu allows to set the parameters on the X axis. Two entries are 
available: 

1. Time, to display “RR vs Time” information 
2. RR, to display “Poincaré” plot; refer to section 3.11.1. 

 
The second drop-down menu allows the parameter of the Y axis to be set. The available 
entries depend on the previous X axis selection.  
In case of Time trend, the available options are: 

- RR: to plot the RR value on the x-axis versus the previous RR value on the y-axis 
- HR: heart rate 
- DRR: ratio between the current RR value and the previous RR value 
- DRR2: ratio between the current RR value and the value before the previous RR value 

 

 
 
The “Poincaré order” drop-down menu is enabled only if the RR entry of the X Axis section 
has been selected; refer to section 3.11.1. 
 
 
In the “Label filter” section on the top of the diagram (see Figure 58), it is possible to filter 
the dots to be displayed. The possible entries are: 

- All: all beats are displayed  
- N-N: only ‘N’ beats followed by an ‘N’ beat are displayed 
- V-V: only ‘V’ beats followed by a ‘V’ beat are displayed 
- S-S: only ‘S’ beats followed by an ‘S’ beat are displayed 
- N-V: only ‘N’ beats followed by a ‘V’ beat are displayed 
- V-N: only ‘V’ beats followed by an ‘N’ beat are displayed 
- N-S: only ‘N’ beats followed by an ‘S’ beat are displayed 
- S-N: only ‘S’ beats followed by an ‘N’ beat are displayed 
- N-U: only ‘N’ beats followed by an ‘U’ beat are displayed 
- U-N: only ‘U’ beats followed by an ‘N’ beat are displayed 
- N-B: only ‘N’ beats followed by an ‘S’ beat are displayed 
- B-N: only ‘S’ beats followed by an ‘N’ beat are displayed 
- *-N: only beats followed by an ‘N’ beat are displayed 
- N-*: only ‘N’ beats are displayed 
- *-V: only the beats followed by a ‘V’ beat are displayed 
- V-*: only ‘V’ beats are displayed 
- *-S: only beats followed by an ‘S’ beat are displayed 
- S-*: only ‘S’ beats are displayed 
- *-B: only beats followed by a ‘B’ beat are displayed 
- B-*: only ‘B’ beats are displayed 
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- *-U: only beats followed by a ‘U’ beat are displayed 
- U-*: only ‘U’ beats are displayed 
- Not V: all Normal beats are displayed (except ‘V’ beats) 

 

 
Figure 58 – “Label Filter” combo-box menu in the Trends tab 

 
In case one of the label filtering options from the second to the twelfth is selected, it is then 
possible to select which RR intervals shall be displayed. 

For example, in case N-V label filter option is selected   , by 
selecting the N check-box, the display of all normal beats followed by a Ventricular beat is 
enforced; on the other hand by selecting the V check-box, the display of all Ventricular beats 
preceded by a normal beat is enforced. 
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Figure 59 – Trends display with N-V label filtering option.  On the left where the “V” check-box is selected, V 
beats preceded by N beats are displayed; on the right where the “N” check-box is selected, N beats followed 

by V beats are displayed 

 
Clicking the secondary mouse-button on the selected region, if Rhythm & Beat Editor is 
available and thus editing is allowed, the following context menu is displayed (Figure 60). 
Under this menu, it is possible to: 
 

 
Figure 60 – Context Menu for a selection of dots in the Trends view 

 
• delete selected beats 
• modify selected beat label. The list of available beat categories is: 

▪ N – Normal Beat 
▪ V – Ventricular Beat 
▪ S – Supraventricular Beat 
▪ C – Calibration Pulse 
▪ B – Beat with Bundle Branch Block 
▪ P – Paced Beat 
▪ E – Ventricular Escape Beat 
▪ F – Fusion Beat 
▪ U – Unknown Beat 
▪ X – Artifact 

• Add a noise region around the selected beats 
 
The dots are colored according with the beat label: the default color is green for the Normal 
(all but ventricular and unknown) beats and red for ventricular (V) and unknown (U) beats. 
The selected dots are colored in a different way, only the border keeps the original color.  
 
Clicking the secondary mouse-button out of the selected region, and the Trend is time-
based. The start time of the displayed ECG in the Continuous ECG Viewer/Rhythm and Beat 
Editor is modified according to the selected point and the current start time is displayed in 
the Time-Trends by a vertical bar. 
 

 “Poincaré” Plot 

 
Poincaré plots are return maps in which each result of measurement is plotted as a function 
of a previous one.  
 
Selecting the RR entry in the ‘X’ axis drop-down menu, it is possible to visualize the ECG 
beat information as “Poincaré” display.  
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The second drop-down menu allows the parameter of the Y axis to be set. The available 
entries are: 

- RR: to plot the current RR value on the x-axis versus the previous RR value on the 
y-axis 

- DRR: ratio between the current RR value and the previous RR value 
- DRR2: ratio between the current RR value and the value before the previous RR value 

 

 
 
The “Poincaré order” drop-down menu allows the user to choose the order when true 
Pincaré plot (RR vs RR) is selected.  The available entries are: -5, -4, -3, -2, -1, 1, 2, 3, 4, 
5. 
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Figure 61 – Example of Poincaré plot (RR vs RR-1) 

  

 Trends Option 

The Trends Options dialog is invoked by clicking the   button next to the Axis section. 
 
This dialog is divided in three tabs, as described below: 

• Axis 
• Colors 
• Advanced 

 

 
 

- Axis (for Time Trends) 
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Figure 62 – Trends Option Dialog for Time-Trends plot, Axis tab  

 
In this tab, the user can set the maximum and minimum time-values to display on X-axis 
and the maximum and minimum values for Y-axis. Selecting “Auto”, the graph is updated 
to show all beats according to the Label Filter choice. 

 
 

- Axis (Poincaré Plot) 
 

      
Figure 63 – Trends Option Dialog for Poincaré-like plot, Axis tab. In the first screenshot, the dialog is shown 

on a true Poincaré where both axes is RR interval (and it is possible to bind the two axis). In the second 
screenshot, the dialog is shown on a Poincaré-like where only one axis is RR interval 

 
In this tab, the user can set the maximum and minimum values to display for each axis. 
Selecting “Auto”, the graph is updated to show all the beats, according to the Label Filter 
choice. 
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Figure 64 – Time-Trends and Poincaré plots fixed scale, with the top/left arrows it is possible expand the 

graph to include all ECG beat-dots 

 
 

- Color 

 
Figure 65 – Trend Option Dialog, Color tab 

 

 
In this tab, the user can choose the color of the dots representing the Normal beats, the V 
beat and the color of the selection area. 
 
 

- Advanced 
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Figure 66 – Trend Option Dialog, Advanced tab 

 
In this tab, the user can choose to show or not to show the average RR/HR and its color 
superimposed on the trend. The color of the average as well as the dimension of the time-
window used to compute it can be modified.  
It is also possible to reduce the displayed time to a given window (default: 60 minutes), if 
this option is checked, it is possible to scroll the time. 
If the time-scrolling is active, it is possible to display a context view of the whole trend above 
the ‘reduced’ one, as shown in Figure 57. 
In the context view, the portion displaying time is highlighted with a grey window and it is 
possible to scroll the trend using that window, which can be reduced and enlarged using 
the mouse, changing the displayed time. 
The options in the “Advanced” tab takes effect only when the displayed trend is time based. 
 

 Families Trends 

In case the “Beat measures analysis” (3.21) has been performed, it is possible to review the 
computed measures, changing the parameter of the Y axis. The available measurements 
are: 

- RR(Fam), RR of the representative beat of the family 
- QT, QRS, PR, Pdur, QTp, TpTe, JTp, QTcB, QTcF, Tamp 
- ST Elevations (in according to the analysis options, ref. sec. 3.21.1 for details) 
- ST Area (only in case of multiple elevations points) 
- ST Slope (only in case of multiple elevations points) 
- T Area 
- T Symmetry 
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The measures are displayed with grey dots to distinguish them from the beats (see Figure 
68). 
Once a measure is selected on the Y axis, the ‘label filter’ menu (Figure 58) is hidden and 
substituted by the ‘lead’ and ‘period’ menu. 
Since the analysis can be performed on several leads (in addition to the VM) and on several 
periods (ref. to 3.21.1 ), it is possible to change the current lead and period. 
 

 
 
The ‘period’ menu is available only in case a multiple-period analysis has been performed. 
 
For the beats it is possible to select one or more families and review them in the “adjust 
measures dialog box” (ref. to 3.21.3 for details). 
It is also possible to select all the displayed families and review them by double-clicking on 
the trends. The families’ navigation in the ‘adjust measures dialog” starts from the family 
adjacent to the mouse-click position (for example, see Figure 67). 
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Figure 67 – Adjust measures dialog: all families selected. The families’ navigation starts at the 1258th family 

selected by double-clicking on trends 

 
 

 
Figure 68 – Family-Trends plot: the grey dots represent the selected measures of the computed families 
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 Table Display 

 
Under the Table tab, ECG and Rhythm summary information is reported in a tabular format 
(see Figure 69). 
 
In the table, the following can be reported for each time bin (the default value is one hour), 
for day/night periods and for the entire record: 

• Analysed time, in percentage against the time interval length; 
• Beat-related values (RR/HR min, max, mean and standard deviation) and up to 9 

beat-label-related value highlighted in red: N (normal sinus rhythm), PVC 
(ventricular), S (supraventricular), Pace (paced), Calib (calibration pulse), Fusion, 
Unknown, Vesc (ventricular escape), BBB (bundle branch block) 

• Up to 21 Rhythm related values, highlighted in green: 
o Brady (bradycardia) 
o Pauses 
o Prolonged RR Interval 
o SV Tachy (supraventricular tachycardia) 
o SVPB Isolated (isolated supraventricular beat) 
o SV Couplet (supraventricular couplet) 
o SV Run (supraventricular run) 
o SV Bg (supraventricular bigeminy) 
o SV Tg (supraventricular trigeminy) 
o ATachy (atrial tachycardia) 
o AFib (atrial fibrillation) 
o AFlutter (atrial flutter) 
o V Tachy (ventricular tachycardia) 
o VFib (ventricular fibrillation) 
o VFlutter (ventricular flutter) 
o Torsade de Pointes 
o V Isolated (isolated ventricular Beat) 
o V Couplet (ventricular couplet) 
o V Run (ventricular run) 
o V Bg (ventricular bigeminy) 
o V Tg (ventricular trigeminy) 

• Atrioventricular Block annotations: 
o First-degree AVB 
o Type 1 Second-degree AVB 
o Type 2 Second-degree AVB 
o Third-degree AVB 

• All measure-related min/max/mean values (in case the Beat Measure Analysis has 
been performed), highlighted in blue, related to the lead selected in the drop down 
menu 

o QT 
o QRS 
o PR 
o P dur (P-wave duration) 
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o QTp (interval between QRS onset and T-wave peak) 
o TpTe (interval between T-wave peak and T-wave offset) 
o JTp (interval between QRS offset (J point) ad T-wave peak) 
o QTcB (QT interval correct with Bazett’s formula) 
o QTcF (QT interval correct with Fredericia’s formula) 
o T amp (T-wave amplitude) 
o ST Ele (ST displacement) 
o ST Area (area of ST segment from the first to the last elevation point 

analysed; only available if more than one elevation point is analysed) 
o ST slope (only available if more than one elevation point is analysed and it 

will be the linear interpolation of ST displacement at the various points) 
o T Area (T-wave area; computed from T-wave onset and T-wave offset) 

 

 
Figure 69 – Table tab display 

 
The two buttons on the top left allow to access table configuration option (refer to section 
3.12.2) and to export the table in CSV format.  
The drop-down menu, only available in case Beat Measure Analysis has been performed, 
allow to select the lead to which the annotations are related. 
 
The table display is interactive: upon clicking the primary mouse-button on HR and RR 
min/max event or to rhythm annotation events or to beat label on the table, the Continuous 
ECG Viewer or the Rhythm & Beat Editor gets updated to show the selected item. 
In Continuous ECG Viewer or Rhythm & Beat Editor, it is then possible to navigate through 
the selected items using the navigation buttons described in section 3.4.9. 
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By clicking the primary mouse-button on beat measurement min/max values, the Adjust 
Measure dialog will be loaded to allow manual adjustment of ECG annotations, refer to 
section 3.21.3 for more details. 
 

 
Figure 70 – Table display: selection of the “RR min” value in the fourth time-interval (12:00:00 - 12:59:59) 

of the recording synchronized with the Rhythm & Beat Editor 

 

 Table in Multiday analysis 

In the Table tab, multiday Rhythm summary information is reported in a tabular format (see 
Figure 71). 
 
The following information are reported for each time bin of a fixed length of 24 hours and 
for day/night periods for each day and for the entire record: 

• Analysed time, in percentage against the time interval length; 
• Beat-related values for RR and HR (min, max, mean and standard deviation) 
• 8 Rhythm related values, highlighted in green: 

o Pauses 
o ATachy (atrial tachycardia) 
o AFib (atrial fibrillation) 
o AFlutter (atrial flutter) 
o V Tachy (ventricular tachycardia) 
o VFib (ventricular fibrillation) 
o VFlutter (ventricular flutter) 
o Torsade de Pointes 

• Atrioventricular Block annotations 
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Figure 71 – Table tab display in case of multiday analysis 

 
The two buttons on the top left allow to access table configuration option (refer to section 
3.12.2) and to export the table in CSV format.  
 
The table display is interactive: upon clicking the primary mouse-button on HR and RR 
min/max event or to rhythm annotation events on the table the Continuous ECG Viewer or 
the Rhythm & Beat Editor gets updated to show the selected item. 
In Continuous ECG Viewer or Rhythm & Beat Editor, it is then possible to navigate through 
the selected items using the navigation buttons described in section 3.4.9. 
 

 Table Options 

To customize the reported information, it’s necessary to invoke the Table Options dialog, as 

shown in Figure 72, by clicking the  button or via the corresponding entry in the 
‘Options’ menu,  (see ref. 3.29.6). 
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Figure 72 – Table Options Dialog 

 
In the section “Select Columns”, it is possible to set the columns to display, namely: 
HR and rhythm annotations 

• RR interval and heart rate  
o weather the standard deviation shall be provided for RR interval and heart rate 

• atrial fibrillation, atrial flutter and atrial tachycardia 

• ventricular fibrillation, ventricular flutter and Torsade de Points 
• bradycardia, pauses and prolonged RR 
• supraventricular and ventricular arrhythmias 

o weather supraventricular and ventricular bigeminy and trigeminy shall be 
reported 
 

• analyzed time 
 

• beat labels: N (normal sinus rhythm), PVC (ventricular), S (supraventricular), Pace 
(paced), Calib (calibration pulse), Fusion, Unknown, Vesc (ventricular escape), BBB 
(bundle branch block) 

 
In the section “Row Options”, it is possible to customize the resolution of the rows of the 
table:  

• the Time Bins drop-down menu allows to specify the size of sub-summary intervals 
expressed. The allowed Time Bins entries are: 10, 15, 20, 30, 60, 90, 120, 180 
minutes and 5, 12 or 24 hours; default value being 60 minutes (i.e. one hour) 



AMPS-TD-RD-UM-Electra_320 v01 Electra_320 User Manual 

 

 
Property of AMPS llc - Company Confidential Page 80 of 174 

 

• the initial time of each row (minutes:seconds); default value being “00:00”. This 
feature allows the synchronization of the table with dosing time or to a particular 
event 
 

In the section “Day/Night Options”, it is possible to customize: 
• The Day/Night periods and an additional optional period (T3) by entering start and 

end time 
• The time for day change. By default it is the set tot the recording start time, but it 

can be modified as needed.  
 

3.12.2.1. Table Options in Multiday analysis 

 
In case multiday analysis was performed, most table options are fixed, as shown in Figure 
73. 
 

 
Figure 73 – Table Options Dialog, for Multiday recordings 

 
• Columns are fixed and allow the display of 

o min/max/mean and std values for both RR and HR 
o Pause events 
o Atrial Tachycardia events 
o Atrial Fibrillation events 
o Atrial Flutter events 
o Ventricular Tachycardia events 
o Ventricular Fibrillation events 
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o Ventricular Flutter events 
o Torsade de Pointes 
o Atrioventricular blocks 

• ECG Beats are not displayed  
• Time Bins size of sub-summary intervals is set to 24 hours 
• Initial time of each time bin (minutes:seconds) is set to “00:00” 

  
 In the section “Day/Night Options”, it is possible to customize: 

• The Day/Night periods and an additional optional period (T3) by entering start and 
end time 

• The time for day change. By default it is the set tot the recording start time, but it 
can be modified as needed.  

 Templates Display 

 
In the Templates tab, ECG templates generated using ABILE algorithm are displayed (see 
Figure 74). The algorithm used for the generation of the templates is based on morphology 
comparison of ECG beats with same label. Beats with high morphological correlation are 
grouped under the same template which is classified according to the beat label.  
 
This display is not available in case of Multiday recordings. 
 

 
Figure 74 – Template tab display 

 
 
The template ID and the overall number of beats of the Template is indicated under each 
template; templates are sorted by template ID. 
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The lower the template ID, the greater the number of beats belonging to the template. 

 
The templates are grouped and visualized by beat label. It is possible to select the type of 
template to be visualized, from those identified in the continuous recording, under the 
toolbar.  
 

 
 
As shown below, the information regarding the displayed templates appears at the top-left 
of the templates indicating the templates type, the overall number of beats that belong to 
the selected template type and the number of templates of the given type. Between square 
brackets, the ID of the selected templates is reported. 
 

 
 
Information regarding the display of templates is indicated at the bottom-right of the 
Templates page indicating the templates displayed on the current page (e.g. from 1 to 24 
of 118 are displayed as shown in the example below). 

 

 
 

The Template display is interactive: clicking the primary mouse-button on a template, 
Continuous ECG Viewer or Rhythm & Beat Editor is updated to show the first beat that 
belongs to the selected template (Figure 83). It is also possible to select more templates by 
holding down the CTRL button of the keyboard or selecting several contiguous templates 
holding the SHIFT button. 
In Continuous ECG Viewer or Rhythm & Beat Editor, is then possible to navigate through 
the ECG beats of a selected template using the navigation button, as described in section 
3.4.9. 
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Figure 75 – Selection of template synchronized with the Rhythm & Beat Editor 

 
The buttons  / allow to hide/show the template toolbar, described here below, thus 
maximizing the space for templates display. 

 Display Customization 

 
Under the Template tab, the user can customize the visualization of templates by adjusting 
the various parameters via the toolbar buttons or drop-down menu entry. 
 

 
 

3.13.1.1. Voltage Display Customization 

 
The amplitude resolution for ECG display in the Template Viewer and in the Move Beat 
Dialog can be configured by selecting the desired amplitude resolution from the first drop-
down menu from the left. 
In case of squared grid (refer to Grid Options tab of 3.29.1 - Generic Display Options, 
starting on page 154) the drop-down menu for amplitude resolution selection is not available 
as the amplitude is automatically derived from the length of the template. 

3.13.1.2. Superimposition Display 

 
Standard/superimposed ECG waveform display can be toggled using the first toolbar button 
from the left. 
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3.13.1.3. Vertical Shift 

When the superimposed mode is activated, it is possible to separate the leads using the 
vertical shift slider. 
 

 
 

3.13.1.4. Number of Templates Display Customization 

 
Increase/decrease the number of templates displayed per page by adding or removing a 
row.  
 
 

3.13.1.5. Template Types Comparison 

 
Single template type or multiple template types comparison can be toggled using the fourth 
toolbar button from the left.  
 

 Auto Merge Template 

 
Upon clicking this button, templates of the same type with high correlation will be merged. 

 

 Template Visualization Option 

 
Clicking on the “Edit Settings” button, the “Template Visualization Options” dialog is opened. 
In this dialog, the user can choose the wave complexes to be visualized. The allowed 
selections are: PQRST, PQRS, QRS and QRST complexes, while the default is QRS. 
Note that beat detection and automatic template identification is only related to the QRS 
complex, P and ST complexes are not used. 
The options dialog can also be invoked via the corresponding entry in the ‘Options’ menu 
(Refer to section 3.29.6). 
 
Here it is also possible to select the leads to be visualized. 
By default, all leads used in the Beat Detection process are displayed and it is possible to 
enable/disable the display. 
 



AMPS-TD-RD-UM-Electra_320 v01 Electra_320 User Manual 

 

 
Property of AMPS llc - Company Confidential Page 85 of 174 

 

  
Figure 76 – Temple Visualization Options dialog. Example where Beat Detection was performed  

on leads II, aVR and all precordial leads (V1-V6) 

 
 

 Editing Single Template 

Clicking the secondary mouse-button on a single template, the following context menu is 
displayed (Figure 77) where it is possible to: 
 

  
Figure 77 – Context Menu for a selection of a single template 

  
• Relabel beats (Only if Rhythm & Beat Editor is available) 

o the list of available beat categories is displayed (Figure 78), these being: 
▪ N – Normal Beat 
▪ V – Ventricular Beat 
▪ S – Supraventricular Beat 
▪ C – Calibration Pulse 
▪ B – Beat with Bundle Branch Block 
▪ P – Paced Beat 
▪ E – Ventricular Escape Beat 
▪ F – Fusion Beat 
▪ U – Unknown Beat 
▪ X – Artifact 
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Figure 78 – Context Menu to change ECG beat labels for a single template selection 

 
• Explode template (the current template will be exploded to generate as many 

templates as the number of beats within selected template). 
• Adjust the beat detection position (Only if Rhythm & Beat Editor is available). The 

“Move Beat” dialog is displayed where the beat detection position can be edited as 
shown in Figure 79. In this dialog box, it is also possible to adjust the display 
organization for a more precise caliper editing. 
Upon clicking the OK button, the detection position gets modified accordingly for all 
ECG beats belonging to the selected template. 

• Add Noise Region around all ECG beats belonging to the selected template (a noise 
region will be entered, centered on the beat and extended in both right and left 
direction to the first valid beat). (Only if Rhythm & Beat Editor is available) 

• Delete all beats belonging to the selected template (Only if Rhythm & Beat Editor is 
available). 

• Unselect template. 
 



AMPS-TD-RD-UM-Electra_320 v01 Electra_320 User Manual 

 

 
Property of AMPS llc - Company Confidential Page 87 of 174 

 

 
Figure 79 – Manual adjustment of a template detection position 

 

 Editing on a selection of templates 

Clicking the secondary mouse-button on a selection of templates, the following context 
menu (Figure 80) is displayed, where it is possible to: 
 

 
Figure 80 – Context Menu for a multiple templates selection 

 
• Relabel beats (Only if Rhythm & Beat Editor is available) 

o the list of available beat categories is saved as for a single template selection 
(section 3.13.4 and Figure 78). 

• Merge selected templates (Only if Rhythm & Beat Editor is available, the selected 
templates will be merged into a single template). 

• Add Noise Region around all ECG beats belonging to the selected templates (a noise 
region will be entered, centered on the beat and extended in both right and left 
direction to the first valid beat). (Only if Rhythm & Beat Editor is available) 

• Delete all beats belonging to the selected templates (Only if Rhythm & Beat Editor is 
available). 

• Unselect templates. 
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 Histogram Display 

 
In the Histogram tab, the ECG beat information is provided as an interactive histogram 
display (Figure 81). 
 
This display is not available in case of Multiday recordings. 
 
Histogram allows a visual interpretation of numerical data by indicating the number of beats 
that lie within a range of values, called a class or a bin. The frequency of the beats that falls 
in each class is depicted by the use of a bar.  
 

 
Figure 81 – Histogram tab display 

 
The leftmost drop-down menu allows the user to set the variable on the X axis. Three entries 
are available: 

1. RR; 
2. DRR: ratio between the RR value and the previous RR value; 
3. DRR2: ratio between the RR value and the value before the previous RR value. 
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In the “Label filter” drop-down menu on the top of the histogram (see Figure 82), it is 
possible to filter the beats to depict their label according. The possible entries are: 

- All: all beats are displayed  
- N-N: only ‘N’ beats followed by an ‘N’ beat are displayed 
- V-V: only ‘V’ beats followed by a ‘V’ beat are displayed 
- S-S: only ‘S’ beats followed by an ‘S’ beat are displayed 
- N-V: only ‘N’ beats followed by a ‘V’ beat are displayed 
- V-N: only ‘V’ beats followed by an ‘N’ beat are displayed 
- N-S: only ‘N’ beats followed by an ‘S’ beat are displayed 
- S-N: only ‘S’ beats followed by an ‘N’ beat are displayed 
- N-U: only ‘N’ beats followed by an ‘U’ beat are displayed 
- U-N: only ‘U’ beats followed by an ‘N’ beat are displayed 
- N-B: only ‘N’ beats followed by an ‘S’ beat are displayed 
- B-N: only ‘S’ beats followed by an ‘N’ beat are displayed 
- *-N: only beats followed by an ‘N’ beat are displayed 
- N-*: only ‘N’ beats are displayed 
- *-V: only the beats followed by a ‘V’ beat are displayed 
- V-*: only ‘V’ beats are displayed 
- *-S: only beats followed by an ‘S’ beat are displayed 
- S-*: only ‘S’ beats are displayed 
- *-B: only beats followed by a ‘B’ beat are displayed 
- B-*: only ‘B’ beats are displayed 
- *-U: only beats followed by a ‘U’ beat are displayed 
- U-*: only ‘U’ beats are displayed 
- Not V: all Normal beats are displayed (except ‘V’ beats) 

 

 
Figure 82 – “Label Filter” combo-box menu in the Histogram tab 

 

Clicking the  icon, it is possible to reset the current histogram selection, as also by 

clicking the  button from Continuous ECG Viewer or Rhythm & Beat Editor toolbar.  
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The buttons  / allow to hide/show the histogram buttons, described here below, thus 
maximizing the space for histogram display. 
 
The Histogram display is interactive: clicking the primary mouse-button on a bar of the 
histogram, the Continuous ECG Viewer or the Rhythm & Beat Editor can be updated to show 
the first ECG beat that lies in the selected range (Figure 83). It is also possible to select 
more than one consecutive bars. 
In Continuous ECG Viewer or Rhythm & Beat Editor, it is then possible to navigate through 
the selected ECG beats using the navigation button as described in section 3.4.9. 
 

 
Figure 83 – Selection of a histogram bar synchronized with the Rhythm & Beat Editor 

 
 

 Histogram Options  

The Histogram Options dialog box is invoked by clicking the   button, or via the 
corresponding entry in the ‘Options’ menu (see ref. 3.29.6). 
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Figure 84 – Options dialog box under the Histogram tab 

 
In this dialog box, it is possible to set up max-min values and the number of bins for RR 
and DRR variables. 
It is also possible to change the order of the selected beats: 

- Sorted by time position 
- Sorted by value, shortest first 
- Sorted by value, longest first 

 

 Families-Histogram  

In case the “Beat Measures Analysis” has been performed, it is possible to select 
measured-related items. from the ‘variable’ menu.  

      
 

Families-Histogram allows a visual interpretation of numerical data by indicating the 
number of families that lie within a range of values, called a class or a bin. The frequency 
of the beats that fall in each class is depicted by a bar. 
The Histogram display is interactive: clicking the primary mouse-button on a bar of the 
histogram, the “Adjust Measures Dialog” is displayed showing the families that lie in the 
selected range. It is also possible to select more than one consecutive bars (Figure 85). 
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Figure 85 – Families-Histogram: selection of families having a QT value between 280 and 344 on Lead V1 

 
When a measure-item is selected from the ‘variable’ menu, the ‘label filter’ menu is 
substituted by the ‘Lead’ and ‘Period’ menus.  

 
Available leads are those been measured, selected in the Beat Measures options, with the 
addition of VM (Vector Magnitude lead). 
 
The period menu is available only in case of multi-period beat measure analysis (ref. 3.21). 
 

 Rhythms Display 

Under the Rhythms tab, the RR/HR average trend can be seen and the rhythm annotations 
information is provided as an interactive histogram display (Figure 86). 
 

 
Figure 86 – Rhythms tab display 

 
The value represented on the X axis is the time, and the Y variable changes according to 
the selected rhythm, in the drop-down menu. 
From the “average trend” drop-down menu, it is possible to select the type of the displayed 
average trend (RR or HR). 
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From the “Rhythm” drop-down menu, is possible to select the rhythms to display in the plot.  
 

 
 

Here is the list of selectable items with the related variable in the Y axis, with unit of 
measure, within brackets: 

• None: No rhythm selected, show only average trend 
• AFib: atrial fibrillation (duration, s) 
• ATA: atrial fibrillation, atrial flutter and atrial tachycardia (duration, s) 
• V Rhythms: isolated ventricular beats, ventricular couplets and run (number of beats) 

• SV Rhythms: isolated supraventricular beats, supraventricular couplets and run 
(number of beats) 

• V + SV Rhythms: ventricular and supraventricular rhythms shown together (number 
of beats) 

• Isolated V: isolated ventricular beats (number of beats) 

• Isolated S: isolated supraventricular beats (number of beats) 
• V Couplets: ventricular couplets (number of beats) 
• SV Couplets: supraventricular couplets (number of beats) 
• Bradycardia (average RR, ms) 
• V Tachycardia: ventricular tachycardia (average HR, bpm) 
• SV Tachycardia: supraventricular tachycardia (average HR, bpm) 

• Pause (duration, s) 
• Prolonged RR (duration, s) 
• V Bigeminy: ventricular bigeminy (duration, s) 
• V Trigeminy: ventricular trigeminy (duration, s) 
• SV Bigeminy: supraventricular bigeminy (duration, s) 

• SV Trigeminy: supraventricular trigeminy (duration, s) 
• VFib/VFlu/TdP: ventricular fibrillation, ventricular flutter and Torsade de Pointes 

(duration, s) 
• AVB: atrioventricular blocks (duration, s) 
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o First-degree Atrioventricular Block 
o Type 1 Second-degree Atrioventricular Block 
o Type 2 Second-degree Atrioventricular Block 
o Third-degree Atrioventricular Block 

• ‘ALL’: display all rhythm annotations (duration, s) 
 

The button  allows to activate the zoom feature, refer to section 3.15.1 for possible 
settings, enabling a context view at the bottom showing the entire trends, while on the 
upper part  the zoomed trends is visualized, see Figure 87. The context view can be 
deactivated accessing the rhythm display options. 
 

 
Figure 87 – Rhythm display with zoom activated, with resolution of one hour 

 
Scrolling is possible using: 

• the horizontal scrollbar 
• drag & drop action on the gray highlighted area, using the primary mouse button 

• the yellow left and right arrows beside the context display  /  
 
The buttons  /  allow to hide/show the Rhythms buttons, described here below, thus 
maximizing the space for rhythms display. 
 
The Rhythms display is interactive: clicking the primary mouse-button on an event in the 
rhythms tab, the Continuous ECG Viewer or the Rhythm & Beat Editor is updated to show 
the selected event (Figure 88).  
While, clicking the secondary mouse-button on trend, the Continuous ECG Viewer or the 
Rhythm & Beat Editor is updated to show the selected position. 
The current position shown in the Continuous ECG Viewer or the Rhythm & Beat Editor is 
highlighted with a yellow bar on the rhythms tab. 
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Figure 88 – Selection of a bar in the “Rhythms Display” syncronized with the Rhythm and Beat Editor 

 
It is also possible select more than one rhythm annotations by drawing a rectangle on the 
desired annotations: all the rhythms included (or partially included) in the rectangle will be 
selected, as show in Figure 89 where 16 annotations have been selected. 
 
By clicking the secondary mouse button on an active selection (see Figure 90), it is possible 
to: 

• enter a rhythm annotation from those manually insertable (this is only possible if 
“ALL” entry is selected from “Rhythm” drop-down menu; if “AFib”, “ATA”, 
“VFib/VFlut/TdP” entries,  are selected, only the related subset of the insertable 
annotations will be visible): 

o Atrial Fibrillation 
o Atrial Flutter 
o Atrial Tachycardia 
o Ventricular Fibrillation 
o Ventricular Flutter 
o Torsade de Pointes 

• Enter an AVB (this is only possible if “ALL” or “AVB” entries are selected from 
“Rhythm” drop-down menu) 

o First-degree Atrioventricular Block 
o Type 1 Second-degree Atrioventricular Block 
o Type 2 Second-degree Atrioventricular Block 
o Third-degree Atrioventricular Block 

• enter a noise region 
• delete selected events, in case the selection was performed including at least a 

rhythm annotation 
 
 



AMPS-TD-RD-UM-Electra_320 v01 Electra_320 User Manual 

 

 
Property of AMPS llc - Company Confidential Page 96 of 174 

 

 
Figure 89 – Multiple rhythm events selection on “Rhythms Display” 

 
 

 
Figure 90 – Selection on “Rhythms Display”, allows entering a noise region, a rhtyhm annotaitons or the 

deletion of the selected events 

 

 Rhythms in Multiday analysis 

In case of multiday recordings, the rhythms display is optimized for the report of the rhythm 
annotations subset that can be computed by multiday analysis, namely: 

• Pauses 
• Atrial Fibrillation 
• Ventricular Tachycardia 

 
Rhythm annotations that can be manually inserted, namely 

• Pauses 
• Atrial Fibrillation 
• Ventricular Tachycardia 
• Other ATA: atrial flutter and atrial tachycardia 
• Ventricular Fibrillation, Ventricular Flutter and Torsade de Pointes 

• Atrioventricular blocks 
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For this reason the Rhythm drop-down menu is reduced to include only the above entries. 
Here the list of selectable items with the related variable in the Y axis, with unit of measure, 
within brackets:: 

• None: No rhythm selected, show only average trend 
• AFib: atrial fibrillation (duration, s) 
• ATA: atrial fibrillation, atrial flutter and atrial tachycardia (duration, s) 

• V Tachycardia: ventricular tachycardia (average HR, bpm) 
• Pause (duration, s) 
• VFib/VFlu/TdP: ventricular fibrillation, ventricular flutter and Torsade de Pointes 

(duration, s) 
• AVB: atrioventricular blocks (duration, s) 

o First-degree Atrioventricular Block 
o Type 1 Second-degree Atrioventricular Block 
o Type 2 Second-degree Atrioventricular Block 
o Third-degree Atrioventricular Block 

•  ‘ALL’: display all rhythm annotations (duration, s) 
 

 
 
 
Differently from standard Rhythms, in case of multiday recordings, two levels of zoom are 
available:  

•  activate the zoom to 24 hours 

•  activate the additional zoom, with configurable length on rhythm display options. 
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Figure 91 – Multiday Rhythm display with both zooms activated, with resolution of two hours. 

 
 
By clicking the secondary mouse button on an active selection (see Figure 92), it is possible 
to: 

• enter a rhythm annotation from those manually insertable (this is only possible if 
“ALL” entry is selected from “Rhythm” drop-down menu; if “AFib”, “ATA”, 
“VFib/VFlut/TdP” entries, are selected, only the related subset of the insertable 
annotations will be visible): 

o Atrial Fibrillation 
o Atrial Flutter 
o Atrial Tachycardia 
o Ventricular Fibrillation 
o Ventricular Flutter 
o Torsade de Pointes 

• enter an AVB (this is only possible if “ALL” or “AVB” entries are selected from 
“Rhythm” drop-down menu) 

o First-degree Atrioventricular Block 
o Type 1 Second-degree Atrioventricular Block 
o Type 2 Second-degree Atrioventricular Block 
o Third-degree Atrioventricular Block 

• enter a noise region 
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• delete selected events, in case the selection was performed including at least a 
rhythm annotation 

• select a detailed analysis segment to cut and export; it will then be possible to 
perform standard Beat Detection and Rhythm analysis and that segment on a new 
CER-S session.  
The maximum length of a detailed analysis segment is 24 hours and will be 
automatically reduced to the first 24 hours, in case a selection longer than 24 hours 
was inserted. 
Selected detailed analysis segments will be exported in AMPS compressed format 
(ACecg). 
 
Upon selecting the segment-related item, a new dialog (Figure 93) allowing to specify 
the name of the segment is displayed. This label will be placed in the Visit field of the 
exported record segment. In case a Visit label is already present in the current 
multiday continuous ECG recording, the Visit label of the exported record segment 
will be the concatenation of the two, divided by the text “ - “. 

 

  
Figure 92 – Selection on “Rhythms Display”, allows entering a noise region, a rhtyhm annotaitons, the 

deletion of the selected events and the selection of shorter detailed analysis segment to cut 

 
 

 
Figure 93 – Detailed Analysis segment label entry 

 
To export selected detailed analysis segments, select “Cut and Export Record” entry from 
File menu. 
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 Rhythms Display Options  

The Rhythm Display Options dialog is invoked by clicking the   button, or via the 
corresponding entry in the ‘Options’ menu (see ref. 3.29.6). 
 

 
 
In this dialog is possible to: 

- Zoom the displayed time to a given window (default 60 minutes) enabling the 
scrolling of the X axis 

- Set the maximum Y axis value in case of RR or HR 
- Set maximum displayable value when the Y axis represents the duration of a rhythm 

annotation (see Figure 94 for example)  
- Choose whether the noise regions should be displayed or not; 
- Set the length of the window used to compute the average RR/HR; 
- Choose whether to display the context view of the whole graph in case of time-

scrolling or not. 
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Figure 94 – Example of a “Rhythms Display”  with scrolling enabled on a 60 minutes length window, 

displaying the context view. The noise is shown (in grey) and the maximum displayable duration value is set 
to 100 seconds 

 

 Measures Table Display 

In the Measures Table tab (Figure 95), the families’ measure information is provided in an 
interactive table. This tab is available only with the Beat Measure Platform (refer to section 
3.21 for details). 
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This display is not available in case of Multiday recordings. 
 
The table reports all measures of all measured leads with the addition of VM, for each family 
(one per row). 
In case of multiple-periods analysis, it is possible to switch between different periods via a 
dedicated menu. 

 
 

  
Figure 95 – “Measures Table” 
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The Table display is interactive: clicking the primary mouse-button on any given value, will  
load the Adjust Measure dialog, where it is possible to manually adjust the ECG annotations, 
refer to section 3.21.3 starting on page 125 for all the details. 
 

 Export Measures Table 

The button  allows to export the content of the table (Figure 96) in a .csv file 
such that one file is created for each period.  
Once the button is pressed, the user is prompted to select the destination folder. 
The file name will be: RecordName_PeriodName_Measures.csv and the values are separated 
by a semicolon. 
 

 
 

 
Figure 96 – Example of measures .csv file, imported in a spreadsheet application  

 

 HRV Menu 

From this menu is possible to view and export results of HRV time domain analysis which is 
automatically computed throughout the recording in windows of 5 minutes length. 
In addition, summary results for Day and night periods and the overall recording are also 
provided.  
 

 
 



AMPS-TD-RD-UM-Electra_320 v01 Electra_320 User Manual 

 

 
Property of AMPS llc - Company Confidential Page 104 of 174 

 

 Lead Modifier Menu 

From this menu (see Figure 97) the user can modify the layout of the continuous ECG 
recording in one of the following ways: 

• Remove aVR, aVL and aVF leads, 

• Remove lead III, aVR, aVL and aVF 
• Reconstruct limb leads, 
• Hide Lead Fail segments, 
• Reconstruct chest leads, CL, CR, CF 

 

 
Figure 97 – “Lead Modifier” Menu 

 
The editing of leads layout is possible because the 6 limb leads (I, II, III, aVR, aVL and aVF) 
are redundant. Only 2 of these leads are required to regenerate the 4 missing ones. 
For this reason, with the menu entry “Reconstruct limb leads”, it is possible to regenerate 4 
missing limb leads, starting with 2 leads from I, II, III, aVR, aVL and aVF. 
 
With the second option, it is possible to reduce the number of leads so that the size of the 
output record exported by CER-S is smaller (30% approximately) than the original 12 Leads 
recording. 
 
In Figure 98, an example of a 12-lead ECG reduced to 9 and 8 leads is displayed. 
 

   
Figure 98 – Example of leads removal: “aVR, aVL and aVF lead removal”, “aVR, aVL, aVF and lead III 

removal” shown respectively on the left and right 
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 aECG Generator (Pollux) Menu 

This menu is used for the generation of the aECG FDA HL7 XML v.2 format. 
Here it is possible to load the different components that characterize the aECG FDA HL7 
format: 

• Timepoint Windows 
• Analysis Windows 
• Protocol Events 

 
Once the components are loaded (at least one AW), it is possible to generate the aECG FDA 
HL7 record. 
 

 
Figure 99 – “aECG Generator” Menu 

 

 Timepoint Windows 

By clicking the first entry ‘Load Timepoint Windows’, a new dialog (Figure 100) is loaded 
where the location of the CSV timepoint file and Timepoint Window size must be specified. 

The location of the file can be selected by clicking the  button and selecting the CSV 
file in the dialog box shown in Figure 101. 
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 Figure 100 – Timepoint Windows settings 

 

 
Figure 101 – Timepoint Windows file selection 

 
 
CER-S supports two CSV Timepoint file formats: 

• Relative Timepoints: In this format, timepoints are expressed as time and can be 
either positive or negative. In this case an additional parameter is required: the 
dosing time that all relative timepoints refer to. 
Dosing time is by default set to the start time of the continuous ECG record and can 
be edited by either entering the value directly using the keyboard or by clicking the 
up/down arrows with the help of a mouse.  
 

 
 
Shown here (below) is an example of a CSV Timepoint file with 4 timepoints, 
expressed in relative times: 1 hour and thirty minutes before dosing, dosing time, 1 
hour after dosing and 5 hours post-dose, respectively. 

 
-01:30:00 
00:00:00 
01:00:00 
05:00:00 

 
• Absolute Timepoints: In this format, timepoints are expressed in time/date format 

(separated by the semicolon “;” character). In this case no dosing time is required. 
Here is an example of a CSV Timepoint file with 3 absolute timepoints. 

 
06:52:00;19/12/2010 
07:52:00;19/12/2010 
11:52:00;19/12/2010 

 
 



AMPS-TD-RD-UM-Electra_320 v01 Electra_320 User Manual 

 

 
Property of AMPS llc - Company Confidential Page 107 of 174 

 

For both file formats, it is possible to set the window size (in second) and the timepoint 
label. These values, both optional, must be set after the time (absolute or relative), 
separated by a semicolon character.  
Here an example of a CSV Timepoint file with 3 absolute timepoints. The first and the third 
have the window size (30 and 45 seconds respectively) set. A label is set for all: 
 

06:52:00;19/12/2010;30;label1 
                                                         07:52:00;19/12/2010;;label2 

11:52:00;19/12/2010;45;label3 
 

If the Timepoint Window size is not set in the .csv file, it shall be entered by either typing 
the value directly using the keyboard or by clicking the up/down arrows with the mouse  

 

 
 

In case the window size is provided in the CSV Timepoint file, the value will override the 
one specified in the software dialog. 
In case the CSV Timepoint file is not in a valid format, the timepoints will not be loaded. 

 
Note that the timepoint window is centered on the nominal timepoint. Thus by specifying 
for example a timepoint at 08:00:00 and a timepoint window size of 5 minutes, the timepoint 
window will start at 07:57:30 and end at 08:02:30. 

 

When the CSV Timepoint file is imported, the Timepoint Window Navigator tab is accordingly 
updated with the loaded timepoint windows. 
Here an example of the three above absolute times with a window size of 3 minutes, loaded 
with the CSV Timepoint file. 
 

 
 
In addition, it is possible to set an observation window that will be entered prior to each 
timepoint window. The length of the observation windows must be entered by either typing 
the value directly using the keyboard or by clicking the up/down arrows with the mouse. 
 

 
 

 Analysis Windows 

By clicking the ‘Load Analysis Windows’ menu entry, a new dialog box (Figure 100) is 
displayed that allows the user to select the folder containing the annotated analysis Windows 
(AWs).  The files in the selected folder must be in aECG FDA HL7 XML v. 1 format. 
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Figure 102 – AWs folder selection 

 
All AWs that have the same Subject ID as the currently loaded continuous ECG and whose 
datetime of recording is within the start-end time of the currently loaded continuous ECG, 
will be automatically loaded. 
 
There are situations where this automatic loading will not be computed. This can be due to 
various situations, the most frequent one being the scenario where AWs were not created 
using AMPS Antares technology and thus ECG were filtered or were time shifted (by less 
than a whole second). 
In these cases, it is possible to load the AW by modifying the “aECGModule.ini” file stored 
in the folder storing CER-S settings. Refer to Section 3.3 of the System Manual for details.  
 
Contact support@amps-llc.com to have a complete explanation of the two available options: 

• CheckThreshold: The value entered allows a threshold to be applied to the sample 
comparison. To compare the samples, the algorithm is designed to compare the 
difference between samples against the Threshold entered. Only if all the differences 
between (AW and CER) samples are below the threshold, the AW qualifies. 
This check is applied together with the time-shift. 
Thus the AW will be loaded, time-shifted by the number of millisecond (< 1000), 
having all the sample-differences below Threshold and minimizing the RMS. 
It must be an integer number representing the value in uV (microVolts). 

 
• UseMinRMS: Enabling this feature allows to load the AW, time-shifted by the 

number of milliseconds (< 1000) minimizing the RMS. 
Zero means OFF, 1 (or any other number) means ON 

 
An AW whose datetime of recording falls within a loaded Timepoint, Window’s start-end 
time will be visualized in the Timepoint Navigator as a child node of the timepoint Window. 

mailto:support@amps-llc.com
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AWs whose datetime of recording do not fall within any of the preloaded timepoint windows, 
will be visualized as newly created timepoint Windows (whose duration matches the AW’s 
duration) that contain a reference to the AW. 
 

        
Figure 103 – Nine AWs loaded in the Timepoint Window Navigator. 

First: AWs correctly loaded in the 3 TPWs, Second: AWs loaded with no TPWs 

 
Even when no Timepoint Windows have been pre-loaded, Analysis Windows will be loaded 
in CER-S and a Timepoint Window will be automatically created with the very same time 
and duration of each AW. 

 Protocol Events 

By clicking the ‘Load Protocol Events’ menu entry, a new dialog box (Figure 104) is loaded 
where the location of the CSV Protocol Events file may be specified. 
Protocol Events must be loaded after Timepoint Windows, as the importation of Timepoint 
Windows will reset the loaded data. 
 

 
 Figure 104 – Protocol Events settings dialog 
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CER-S supports two CSV Protocol Events formats: 
 

• Relative Timepoints: In this format, timepoints are expressed as time and can be 
either positive or negative. In this case an additional parameter is required: the 
dosing time that all relative timepoints refer to. 
Dosing time is set by default to the start time of the continuous ECG record and can 
be edited by either typing the value directly with the keyboard or by clicking the 
up/down arrows with the mouse.  
 

 
 
Given below an example of 4 protocol events in relative time reporting Plasma 
Concentration 1 hour prior to dosing, at the dosing time, 1 hour after dosing and 5 
hours post-dose, respectively. 

 
-01:00:00;PlasmaConc 0 
00:00:00;PlasmaConc 0 
01:00:00;PlasmaConc 32 
05:00:00;PlasmaConc 12 

 
• Absolute Timepoints: In this format, timepoints are expressed in time/date format 

(separated by the semicolon “;” character) and no dosing time is required. 
 

Here is an example of 3 protocol events in absolute time 
 

08:00:00;19/10/2010;PlasmaConc 0 
09:50:00;19/10/2010;PlasmaConc 22 
11:49:00;19/10/2010;PlasmaConc 8 

 

 
Figure 105 – Protocol Events Navigation 
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 Annotation Removal 

Using the “Remove annotations outside TimePoint Windows” entry from the “aECG 
Generator”, it is possible to remove all ECG beat annotations that are not included in the 
loaded Timepoint Windows.  
In this case, beat annotation editing can be limited to the annotations that will affect 
subsequent ECG extractions. 
It is also possible in addition to maintain the annotations within the observation window 
selecting “Remove annotations outside TimePoint Windows (except Observation Window)”. 
 

 aECG Exportation 

Once the components are loaded (at minimum one AW), it is possible to generate a  
continuous ECG recording in the aECG FDA HL7 XML version 2 format by clicking on the last 
entry from the “aECG Generator” menu: “Export aECG FDA HL7 record”. 
 
A new dialog box prompts the user to select the output folder name. Output data will be 
saved with the same filename as the input continuous ECG recording. 
 

 Analysis Menu 

Depending on the licensed version, the software allows to perform different analyses on the 
loaded Continuous ECG Recording, namely Beat Detection, Rhythm analysis and Multiday 
Analysis, using ABILE algorithm. 
 

 
Figure 106 – Analysis menu 

 

 Beat Detection 

To perform ECG beat detection and beat classification, select “Run Beat Detection” from the 

“Analysis” Menu (see Figure 106) or clicking the “Run Beat Detection” toolbar button . 
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Note that the “Beat Detection” process also generates the ECG Templates whose display is 
described in section 3.13. 
Note that beat detection and automatic template identification is only related to the QRS 
complex, P and ST complexes are not used. 
 
Beat Detection can only be performed on Continuous ECG Recording with a maximum length 
of 4 days. 
 
In case ECG annotations are present, before the Beat Detection is performed, a dialog 
appears informing the user that this operation will reset all annotations, as shown below. 
 

 
Figure 107 – Dialog box informing that the Beat Detection will reset all annotations 

 
The time needed for the Beat Detection depends on the recording length, and the following 
display informs the user of the elapsed time and processed percentage. 
 

 
 

In case it is needed, Beat Detection process can be aborted, in which case the status of the 
recording will be set to “BDs”, indicating that Beat Detection process has been stopped. 
 
From the same Analysis menu, it is possible to perform ECG detection on a small portion of 
the continuous ECG recording, selecting “Run Detection (Portion)”. 
Then, the starting position and the length of the ECG portion to be processed, up to a 
maximum of 30 minutes (1800 seconds), must be selected. 
 

 
 
When beat detection is performed, the change of status is reported in CER-S status bar as 
“BD”, while if detection is stopped, status will be set to “BDs”. In case modifications are 
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made by the user the new status is reported in CER-S status bar “BDe”, refer to section 
3.3.3 for all the details on Analysis status.  
 
If manual modifications are made and not yet saved in the ACEA session file, a visual alert 
‘*’ is displayed on the title bar and if the user attempts to close the software or load a new 
record, the following warning message is prompted: 
 

 
 

3.20.1.1. Beat Detection Options 

Selecting “Detection Options” from Analysis menu (Figure 106), a new dialog box is 
displayed (Figure 108) listing the “Beat Detection settings currently used”, and allowing to 
edit the default “Beat Detection settings” saved from the last analysis and restored from the 
“AnalysisModuleOptions.ini” file available in the folder storing CER-S settings. Refer to 
Section 3.3 of the System Manual for details. 
 

    
Figure 108 – “Detection Options” dialog. The “Beat Detection settings currently used” tab is shown on the 

left and the default “Beat Detection settings” shown on the right. 

 
The “Beat Detection settings” tab lets the user: 

• specify the effective length of the rhythm data that will be used by ABILE algorithm 
to compute the beat detection. The default selection is from 0 to 4 days (5760 
minutes).  
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Figure 109 – Default rhythm data length used by ABILE algorithm 

 
• select the sensitivity of the noise detection algorithm between: 

o Low sensitivity 
o Medium sensitivity 
o High sensitivity – default 

• enable/disable the auto-merging of the templates 

• select the leads that the ABILE algorithm will use to perform the beat detection. The 
maximum number of leads to be used is 8. 

 

 
Figure 110 – Noise Detector Sensitivity selection 

 

 Rhythm Analysis 

To perform Rhythm Analysis, select “Run Analysis (Full)” from the “Analysis” Menu (Figure 

111) or clicking the  toolbar button. 
 

 
Figure 111 – “Run Analysis” entry of the Analysis menu 

 
Rhythm Analysis can only be performed on Continuous ECG Recording with a maximum 
length of 4 days.  
 
The (Full) analysis is composed in two steps: 

- Supraventricular beats detection 
- Rhythms detection 

It is possible to perform the sole S beats detection, via the “Detect S Beats Only” menu 
entry, or to perform the sole rhythms detection, via “Find Rhythms Only” menu entry.  
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The rhythm annotations that can be detected automatically are listed below: 

• Atrial Fibrillation 
• Bradycardia 

• Pause 
• Prolonged RR Interval 
• Supraventricular Tachycardia 
• Isolated Supraventricular Beat 
• Supraventricular Couplet 

• Supraventricular Run 
• Supraventricular Bigeminy 
• Supraventricular Trigeminy 
• Ventricular Tachycardia 
• Isolated Ventricular Beat 

• Ventricular Couplet 
• Ventricular Run 
• Ventricular Bigeminy 
• Ventricular Trigeminy 

 
When running “Run Analysis (Full)” and “Find Rhythms Only”, the automatic ECG strips are 
recomputed. 
 
When rhythm analysis is performed, the change of status is reported in CER-S status bar as 
“RA”. In case modifications are made by the user the new status is reported in CER-S status 
bar “RAe”, in case a modification made by the user can alter the analysis results, a visual 
alert reporting that the analysis could be obsolete (“RA Obsolete”) is displayed on the title 
bar and the new status is reported in CER-S status bar “RA(obs)”, refer to section 3.3.3 for 
all the details on Analysis status.  
 

 
 
When the analysis is obsolete, if the user proceeds in printing the report (see section 3.27), 
a message box is prompted informing the user that rhythm annotations are obsolete and 
providing three options: 

• recompute rhythm analysis before printing the report – clicking YES 
• proceed with printing the report, without recomputing rhythm analysis –NO 
• cancel printing - CANCEL 
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If manual modifications are made and not yet saved in the ACEA session file, a visual alert 
‘*’ is displayed on the title bar and if the user attempts to close the software or load a new 
record, the following warning message is prompted: 
 

 
 

3.20.2.1. Rhythm Analysis Options  

 
Selecting “Analysis Options” from the Analysis menu (Figure 111), a new dialog box with 
two tabs (Figure 112) is displayed. This dialog box lists the “Rhythm Analysis settings 
currently used”, allowing the user to edit the default “Rhythm Analysis settings” saved from 
the last analysis and restored from the “ArrhythmiaAnalysisModuleOptions.ini” file available 
in the folder storing CER-S settings. Refer to Section 3.3 of the System Manual for the 
details. 
 

    
Figure 112 – “Rhythm Analysis Settings” dialog box: “Rhythm Analysis settings currently used” tab is shown 

on the left and the default “Rhythm Analysis settings” shown on the right. 

 
Available Rhythm Analysis settings are: 

• Average RR (RRp) Window size: in this section, the user can select the number of 
beats that must be used to compute the RRp.  

o Available entries are 4, 8, 12 and 16, default being 8.  
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• Bradycardia: in this section, to annotate the rhythm as “Bradycardia”, the user can 
set the threshold in bpm and the minimum length of data in seconds. 

o Allowed values for threshold are between 1 and 90 bpm, 45 being the default. 
o Allowed values for minimum length are between 1 and 50 s, 10 s being the 

default. 
• Tachycardia: in this section, to annotate the rhythm as “Tachycardia”, the user can 

set the Ventricular and Supra Ventricular threshold in bpm and the minimum length 
in seconds. 

o Allowed values for threshold are between 1 and 500 bpm, 150 being the 
default. 

o Allowed values for minimum length are between 1 and 50 s, 5 being the 
default. 

• Prolonged RR threshold in percentage. 
o Allowed values are between 10 and 1,000 %, 200 being the default. 

• Pause threshold in ms. 
o Allowed values are between 1,000 and 20,000 ms, 2,500 being the default. 

• Prematurity index in percentage. 
o Allowed values are between 10 and 90 %, 70 being the default. 

• Minimum AFIB length 
o Allowed values are between 0 and 3600 s (1 hour), 0 being the default. 

 
If Beat editing is performed after Rhythm analysis has run, there could be erroneous Rhythm 
annotations still visualized. 
 

3.20.2.2. Permanent Atrial Fibrillation 

 
By selecting “Mark as Permanent Atrial Fibrillation” from the Rhythm menu, an Atrial 
Fibrillation rhythm annotation having the length of the entire record is added. Then, all S 
beats are marked as N and all S-related events are automatically removed. 
 

 
 
Select the entry again to remove the status of permanent Atrial Fibrillation, in this case the 
related annotation is removed. 
 
This entry is also available in case Multiday analysis has been performed. 
 

 Multiday Analysis 

In case of long recording, the software can perform a simplified Beat Detection and Rhythm 
Analysis, named Multiday Detection which can be launched selecting “Run Multiday 

Detection” entry from the “Analysis” Menu (Figure 113) or clicking the  toolbar button. 
This analysis is designed for the identification of episodes of Atrial Fibrillation, Ventricular 
Tachycardia and Pauses. 
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Multiday Detection can only be performed on Continuous ECG Recording with a length 
between 1 and 30 days. 
 
The Beat detection component will detect the ECG beats, but at the end on analysis beat 
information and beat navigation will not be available and similarly Templates will not be 
computed. 

 
Figure 113 – “Run Multiday Analysis” entry of the Analysis menu 

 
The rhythm annotations that can be here detected automatically are: 

• Atrial Fibrillation 
• Pause 
• Ventricular Tachycardia 

 
The time needed for the Multiday Detection depends on the recording length, and the 
following display informs the user of the elapsed time and processed percentage. 
 

 
 

In case it is needed, Multiday Detection process can be aborted, in which case the status of 
the recording will be set to “MDs”, indicating that Multiday Detection process has been 
stopped. 
 
When multiday analysis is performed, the change of status is reported in CER-S status bar 
as “MD”. In case modifications are made by the user the new status is reported in CER-S 
status bar “MDe”. 
 
If manual modifications are made and not yet saved in the ACEA session file, a visual alert 
‘*’ is displayed on the title bar and if the user attempts to close the software or load a new 
record, the following warning message is prompted: 
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In case of multiday recordings it is possible to select detailed analysis segments to cut and 
export and subsequently to perform standard Beat Detection and Rhythm analysis and that 
segment in a new CER-S session.  
The maximum length of a detailed analysis segment is 24 hours. Refer to section 3.7.5 for 
more details. 
 
When running “Multiday Detection”, the automatic ECG strips are recomputed. 
In case of Multiday analysis, automatic ECG strips are not identified when running “Multiday 
Detection”, but at the time of printing the report. 
 

3.20.3.1. Multiday Analysis Options  

 
Selecting “Multiday Detection Options” from the Analysis menu (Figure 113), a new dialog 
box with four tabs (Figure 114) is displayed. This dialog box lists the “Beat Detection settings 
currently used” allowing to edit the default “Beat Detection settings” and the “Rhythm 
Analysis settings currently used” allowing to edit the default “Rhythm Analysis settings” 
saved from the last analysis and restored from the “LongAnalysisModuleOptions.ini” file 
available in the folder storing CER-S settings. Refer to Section 3.3 of the System Manual for 
the details. 
 
Available Beat Detection settings are:  

• select the sensitivity of the noise detection algorithm between: 
o Low sensitivity 
o Medium sensitivity 
o High sensitivity – default 

• select the leads that the ABILE algorithm will use to perform the beat detection. The 
maximum number of leads to be used is 8. 

 
Available Rhythm Analysis settings are: 

• Ventricular Tachycardia 
o Allowed values for threshold are between 1 and 500 bpm, 150 being the 

default. 
o Allowed values for minimum length are between 1 and 50 s, 5 being the 

default. 
• Pause threshold with values are between 1’000 and 20’000 ms, 2’500 being the 

default. 
• Minimum AFIB length with values are between 0 and 3600 s (1 hour), 0 being the 

default. 
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Figure 114 – “Multiday Detection Settings” dialog box: “Beat Detection settings currently used” and “Rhythm 
Analysis settings currently used” tabs are shown on the top row, left and right respectively; “Beat Detection 

settings” and “Rhythm Analysis settings” tabs are shown on the lower row, left and right respectively. 

 

 Beat Measures Menu 

The software allows to perform automatic measures using BRAVO algorithm. 
To perform the analysis, select “Run Beat Measures” from the “Beat Measures” menu (see 
Figure 115). 
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Beat Measure can only be performed on Continuous ECG Recording with a maximum length 
of 2 days. 
 
The measures can be computed on beats’ family, where each family is a group of contiguous 
beats belonging to the same time-bin. 
The dimension of the time-bin and the settings can be configured in the options dialog 
described in section 3.21.1.   
 

 
Figure 115 – Beat Measures menu 

 
In case the beats’ measures are already present, a dialog box informing the user that the 
operation will delete all the existing measures, is displayed. 
 

 
 

The time needed for the Beat measurements depends on the recording length and the 
number of leads to be measured, and the following display informs the user of the elapsed 
time and processed percentage. 

 

 
 

 
In case it is needed, Beat Measure process can be aborted, in which case the status of the 
recording will be set to “B2Bs”, indicating the process has been stopped. 

 
The computed measures can be reviewed and edited in the graphical pages (Trends, 
Histogram, Table and Measures Table). 
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When Beat Measure is performed, the change of status is reported in CER-S status bar as 
“B2B”. In case modifications are made by the user the new status is reported in CER-S 
status bar “B2Be”. 
If manual modifications are made and not yet saved in the ACEA session file, a visual alert 
‘*’ is displayed on the title bar and if the user attempts to close the software or load a new 
record, the following warning message is prompted: 
 

 
 
In the ‘Beat Measures’ menu, the following entries are available: 

- Beat Measures Options: review and change the analysis options. Refer to section 
3.21.1 for details. 

- Select Unmeasured Families: select this entry to review the beats family having any 
missing measure. See section 3.21.2  for details. 

- Delete All Measures: delete a previously performed analysis. All beat measures and 
families will be deleted. 

- Review Families: review all measured families, see section 3.21.3. 
- Export Measures: export all the computed measures in csv file format. Refer to 

section 3.16.1 for details.  
 

 Beat Measures Options 

Selecting “Beat Measures Options” from the Beat Measures menu (Figure 115), a new dialog 
with two tabs is displayed (Figure 116). The dialog lists the “Beats Measure settings currently 
used” and allows the user to edit the default “Beats Measure settings”, saved from the last 
analysis and loaded from the “BeatToBeatModuleOptions.ini” file available in the folder 
storing CER-S settings. Refer to Section 3.3 of the System Manual for the details. 
 
Available Beats Measure settings are: 

• Leads to be measured: in this section the user can select the leads to be 
measured with BRAVO algorithm.  

• Vector Magnitude (VM): here the user can decide if the Vector Magnitude (VM) 
shall be measured and, in such case, if it shall be computed with all available 
leads or with the above selected subset. 

• Beats to be measured: the size of the window where ECG beats will be grouped 
and averaged. 
Beats are grouped in time-bin families, the bin’s dimension is configurable 
between 30 and 300 seconds (5 minutes) and the default value is 30 seconds. 
For each family, a representative beat is created and measured. 

 



AMPS-TD-RD-UM-Electra_320 v01 Electra_320 User Manual 

 

 
Property of AMPS llc - Company Confidential Page 123 of 174 

 

 
 

 

    
Figure 116 – “Beats Measure Settings” dialog: “Beats Measure settings currently used” tab is shown on the 

left and the default “Beats Measure settings” tab is shown on the right. 

 
 

• Periods Selection: it is possible to analyze the entire recording or select up to 
three periods of analysis. The three periods are independent and can be 
overlapped. 
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• ST Analysis Settings: the application provides an analysis of the ST segment. 

it is possible to set: 
o The ST elevation point (in ms after the Qon, accepted values between 

0 and 300 ms, default being 80 ms). 
o The number of the elevation points (accepted values between 1 and 

20, default being 1). 
o The distance between the elevation points (valid only in case of # of 

elevation points greater than 1, accepted values between 1 and 20, 
default being 10 ms). 

 
In case the number of elevation points is greater than 1, the area and the 
slope of the ST segment are also computed.  
 

 
 

 Review Unmeasured Families 

To review the families having any missing measures, select the “Review Unmeasured 
Families” entry of the Beat Measures menu. 
Selecting the entry, a new dialog box is displayed where it is possible to filter the 
unmeasured families (Figure 117). 
It is possible to select the missing calipers to search. The calipers that can be selected are: 
Pon, Poff, Qon, Qoff, Soff, Toff, Tmax and Isoelectric. All the families having any of the 
selected calipers missing will be reviewed. 
 

 
Figure 117 – Select Unmeasured Families dialog 
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It is possible to change the lead and the period to select unmeasured families. The period 
menu is available only in case of multiple-period analysis. 
 
Pressing the OK button, the ‘Adjust Measures’ dialog box is shown and the selected 
unmeasured families can be reviewed and manually measured (refer to section 3.21.3 
below). 
 

 Adjust Measures Dialog 

The measured families can be reviewed in the ‘Adjust Measures dialog’ (Figure 119 – Adjust 
Measure dialog). 
This dialog is used to review a selection of families. The representative beat of the current 
family along with its calipers is displayed. 
On the right of the ECG signal are reported the family’s measures of the displayed lead(s) 
(Figure 118): PR, QRS, JT, QTp, TpTe, JTp, Pdur, Tamp, ATcB, QTcF, ST Analysis Data (ST 
Elevation(s), ST Area and ST Slope), T Wave Parameters (T Area, T Symmetry and T Wave 
times). 
 
Information about the currently displayed family are available in the bottom of the dialog. 
 

 

 
Figure 118 – Measures Panel of the Adjust Measures dialog 
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Figure 119 – Adjust Measure dialog 

 

3.21.3.1. Navigation 

When multiple families are selected via one of the available “navigation” modules 
(Histograms, Tables or Trends) or by one of the following entries of the Beat Measures 
menu (“Review Unmeasured Families” or “Review Families”) in the Adjust Measures Dialog, 
it is possible to navigate within the selection. Namely it is possible to display the 
previous/next or first/last item via dedicated toolbar buttons. It is also possible to auto-play 
the navigation. 
 

 
 

In case of auto-play (the green arrow button), it is possible to select the time (in 
milliseconds) which must elapse between a family and the next using the menu above the 
measures panel.  
 

 
 

3.21.3.2. Lead Display Customization 

 
The number of leads to display can be configured by selecting the appropriate entry from 
the leftmost drop-down menu.  
The displayed time is fixed to 1.2 seconds. 
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3.21.3.2.1. Voltage Display Customization 

 
The amplitude resolution to display can be configured by selecting the desired resolution 
from the third drop-down menu from the left. 
Available voltage resolutions are between 1 and 8 mV. 
 

3.21.3.2.2. Superimposition Display 

 
Standard/superimposed ECG waveform display can be toggled using the first toolbar button 
from the left. 
Here below in Figure 120 is an example of Superimposed ECG waveforms.  
 

 
Figure 120 – Superimposed mode in the Adjust Measures dialog. The calipers are related to the VM, which is 

displayed with a green line. 

 
 
In case of superimposed mode, the displayed calipers are related to the VM and the reported 
measures in the panel on the right are the global measures. 
 

3.21.3.2.3. Measures Editing 

If the Rhythm and Beat Editor is active and the modifications are allowed, in the Adjust 
Measures dialog it is possible to manually adjust, add or remove the calipers. 
To select a caliper, click with the primary mouse button on it. Once a caliper has been 
selected, the left or right arrows keys (or the related shortcut keys) can be used to adjust 
its position, moving the caliper sample by sample, but it is also possible to adjust measure 
position, moving 10 samples at a time. 
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Caliper editing can also be performed via drag and drop with the primary mouse button. 
 
Clicking the secondary mouse button, a context menu composed of a list of the calipers is 
displayed. 

 
 

Selecting one of the listed calipers, it is possible to change its position (if it is already present) 
or add a new caliper (if the selected one is not present). 
If the click is on an existing caliper, an entry aimed at deleting the selected caliper is added 
to the list. 

 
 
The measures displayed in the right panel will be real-time update for each caliper 
modification (correction, addition or removal). 
  

To close the Adjust Measures Dialog, click on  or on  buttons. In the 
first case all the modifications will be saved, otherwise they will be lost. 
 

 Templates Generator Menu 

The software allows the users to generate templates starting from the already existing beat 
annotations using ABILE algorithm. To perform the analysis, select “Generate Templates” 
from the “Templates Generator” Menu (Figure 121). 
The generated templates can be reviewed in the display described in section 3.13. 
 

 
Figure 121 – Templates Generator menu 
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In case templates are present, a dialog appears informing the user that this operation will 
reset all templates, as shown below: 
 

 
 

The time needed for the Templates Generation depending on the recording length, the 
following dialog informs the user about the elapsed time and allows to end the process. 
 

 
 

In case it is needed, Templates Generation process can be aborted by clicking the Stop 
button. 

 Templates Generator Options  

 
Selecting “Templates Generation Options” from the Templates Generator menu (Figure 
121), a new dialog with two tabs is displayed (Figure 122). This dialog lists the “Rhythm 
Analysis settings currently used” and allows editing of the default “Rhythm Analysis settings” 
saved from the last analysis and restored from the “AnalysisModuleOptions.ini” file available 
in the folder storing CER-S settings. Refer to Section 3.3 of the System Manual for the 
details.  
 

    
Figure 122 – “Templates Generator Settings” dialog. “Templates Generator settings currently used” tab is 

shown on the left and the default “Rhythm Analysis settings” is shown on the right. 

 
The Templates Generator Settings tab lets the user select the leads that the ABILE algorithm 
will use to generate the templates. 
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It is also possible to enable the auto merging of templates at the end of the generation. 
 

 Trigger Jitter Menu 

The software allows to adjust the beats’ position, centering it on the R peak, from the 
“Trigger Jitter” Menu (see Figure 123). 
 

 
Figure 123 – Trigger Jitter menu 

 
The time needed for the Trigger Jitter depends on the recording length. The following dialog 
informs the user of the elapsed time. 
 

  
 
 

 Trigger Jitter Options  

 
Upon selecting “Trigger Jitter Options” from the Trigger Jitter menu, the following dialog is 
displayed: 
 

 
 

From the options dialog, it is possible to select the leads to be used for the trigger jitter. 
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 Session saving 

 
In case Beat Detection/Editing, Arrhythmia analysis/editing or Beat Measure analysis/editing 
has been performed, it is possible to save the current state in “ACEA” binary session file that 
will be outputted in the same folder as the Continuous ECG recording.  
The session file will be automatically restored when the recording is loaded. 
 

To save the current session, select “Save Session” entry from “File” menu, click on  
button or use the related shortcut key. 
 
Note that if any change has been made, upon closing the software, the user will be prompted 
to save the modifications as shown below: 
 

 
 

 Reset Editing 

To reset all performed editing, from “File” menu select the “Reset Editing” entry. A message 
box alerting the user that the operation is unrecoverable is shown. 
 

 
 
By pressing OK all the performed modifications will be lost. 
 

 Continuous ECG exportation  

When a Continuous ECG recording has been loaded in the software, it can be exported in 
various formats, depending on the available plugin provided with the installation (contact 
support@amps-llc.com to have the list of available output formats), by selecting the Filed -> 
Export Record entry from File menu. 
The “Save As” dialog will be prompted, where the user will select the location to export the 
data and the export format.  

mailto:support@amps-llc.com
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There are two main export features, one that allows the exportation of the Continuous ECG 
recording in a different format and the exportation of the sole results of the analyses, 
typically in ACEA XML, briefly described in 3.26.4 and more deeply in section 3.5 of the 
System Manual. 
The main formats for the exportation of the Continuous ECG recording are “ISHNE”, “MIT 
(WFDB)” and AMPS compressed format (ACecg), the format use for exportation of detailed 
analysis segments. In case of the former export format it is possible to select to export: 

- ISHNE waveforms and annotations (in TXT format) 
- ISHNE waveforms only 
- ISHNE annotations (in TXT format) 
- ISHNE annotations (in ANN binary format) 
- ISHNE annotations (in CEBA binary format) 

 

 Resampling 

When exporting a Continuous ECG recording, it may be useful to change the sampling-rate 
by over-sampling or down-sampling. This can be performed by modifying, in the “Save As” 
dialog, the desired output sampling-rate. By default, this is set as an input value, however 
the user can instead choose to enter a desired value in the range of 50-1000 Hz. 

 Rescaling 

When exporting a Continuous ECG recording, it may be useful to change the amplitude 
resolution. This can be performed by modifying the desired output amplitude scale in the 
“Save As” dialog. By default, this is set as an input value, but the user can choose to instead 
enter a desired value in the range of 40-1000 count/mV. 
 

 
Figure 124 – Save As dialog, possibility to modify output sampling-rate and amplitude resolution 

 Filtering 

When exporting a Continuous ECG recording, it is possible to apply digital filters to the ECG 
waveforms. 
Four different filters can be applied and the cut-off frequency can be adjusted, namely: 
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• A low-pass filter with default cut-off frequency of 40 Hz 
• An high-pass filter with default cut-off frequency of 0.01 Hz 
• A notch filter with default cut-off frequency of 60 Hz 
• A second notch filter with default cut-off frequency of 50 Hz 

 
In the output dialog the “Enable Filters” checkbox must be enabled in order to apply filtering. 
To configure the order of filtering and the cut-off frequency of each filter, the ”Config Filters” 
button shall be pressed. Here a dialog is shown, allowing to modify the filter settings and 
the filtering sequence. 
 

 
Figure 125 – Filtering configuration dialog. 

 

 ACEA XML 

The software, if the related output plugin has been installed, allows the exportation of the 
entire performed analysis results and settings in XML format. 
This can then allow the importation of analysis results in a database. 
Refer to section 3.5 of the System Manual for the structure of ACEA XML.  
 

 Detailed analysis segments export 

In case of multiday analysis, to export selected detailed analysis segments that have been 
previously selected via Rhythms display (section 3.15.1) Rhythm and Beat editor (section 
3.7.5), select “Cut and Export Record” entry from File menu. 
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 Continuous ECG Report 

At any time during a session of Beat or Arrhythmia Editing, it is possible to print a Continuous 

ECG Report by selecting the “Print Report” entry from the File menu, by clicking the  
button. 
Report can be printed to a standard printer or saved in PDF format and here it is possible 
to specify the sheet size between Letter and A4.  

 
The first page of the Report (Figure 126) always includes a summary of Demographic 
information, the list of medications and referring physician, if available, and at the end the 
Cardiologist’s review statement is reported. This report can be added by clicking the “Add 
Comment” button from the “Report Options” dialog (Figure 128). 
In the footer of each page there is the date when the report was printed and the information 
of the software version. 
 
In the Analysis Data section, the main results are reported, namely: 

• Total number of QRS 
• Overall length of analyzed date and length on noise regions 
• Min/max/mean HR and RR 
• Episodes and overall length of manually insertable events  

o Atrial Fibrillation, Atrial Flutter, Atrial Tachycardia 
o Ventricular Fibrillation, Ventricular Flutter, Torsade de Pointes 
o AVBs 

• Details for VPB and SVPB, including overall number, isolated, couplets, run… 
• VT and SVT details 
• Episodes of Bradycardia, Pauses and Prolonged RR 
• HRV results on the entire recording (if HRV module is available): PNN50, SDNN, 

RMSSD 
• Details of ST Elevation/Depression episodes, per measured lead 

o Total duration of ST displacement episodes 
o Maximum ST Elevation 
o Maximum ST Depression 
o Length of maximum ST displacement episode 
o Maximum HR in any ST displacement episode 

 
In the Analysis Settings section, the details of ABILE and BRAVO settings for Beat Detection, 
Rhythm Analysis and Beat measure are reported, namely: 

• Leads used for Beat Detection 
• Noise sensitivity level 

 
• Prematurity index 
• Average RR (RRp) Window size 
• Prolonged RR threshold  

• Pause threshold  
• Bradycardia threshold and minimum length 
• Supraventricular Tachycardia threshold and minimum length 
• Ventricular Tachycardia threshold and minimum length 
• Minimum length of atrial fibrillation, in case the specified value is above 0 s 
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• Measured Leads in Beat Measure 
• Family Time-bin size 
• Start Elevation point 
• Nb of elevation points 

• Distance between elevation points  
• Elevation Threshold 
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Figure 126 – Example of first page of a Continuous ECG Report, without Beat Measure analysis 
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Figure 127 – Example of first page of a Continuous ECG Report, with Beat Measure analysis 

 
When the “Print Report” entry has been selected, the “Report Options” dialog is prompted 
(Figure 128) where it is possible to choose and configure the sections that should be 
included in the report. 
It is possible to configure the report’s language (current available languages are English, 
French and Italian), via the Language drop-down menu. 
The “Center ID” is manually editable and it will be printed on the report’s header. 
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Figure 128 – “Report Options” dialog for the selection of the sections to be included in the report 

 
Clicking the “Demographics” button, it is possible to display and edit the record’s 
demographics (refer to section 3.28 for details). 
Clicking on the “Review” button, the review dialog is displayed. See section 3.27.1 for 
details. 
Available sections that can be included in the Continuous ECG Report, depending on the 
available analysis modules and analysis results, are: 

• “RR Average Plot” (see Figure 129) - Time RR average plot displays the average 
values of RR interval over time. 

o The size of the window to compute the average RR is customizable, between 
and 1 and 60 minutes. 

o Display of minimum/maximum values and standard deviation can be enabled. 
o RR Extrema for each average window can be displayed. 

• “Rhythms Plot” - Rhythm Annotations against time (see Figure 130): number of 
Rhythm Annotations and the time of occurrence for each episode.  

o Rhythm annotations reported in the plot can be limited only to the ones 
available on the given record. 

• “Rhythms List” - List of significant arrhythmias (see Figure 131) 
The full list of the following rhythms event can be reported, sorted by severity and 
reporting: start time, length and other details, depending on the event 
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o Atrial Fibrillation (min/max heart-rate is reported for each event type) 
o Pauses 
o Ventricular Tachycardia (number of beats and mean/min/max heart-rate are 

reported for each event) 
o Supraventricular Tachycardia (number of beats and mean/min/max heart-rate 

are reported for each event)  
o Ventricular runs (number of beats and mean/min/max heart-rate are reported 

for each event) 
o Supraventricular runs (number of beats and mean/min/max heart-rate are 

reported for each event) 
• Table - summary information for ECG beats and Rhythm Annotations in tabular 

format (see Figure 132). 
o Table layout follows the one selected for the graphical display, namely the 

columns to be reported, the size of time Bins and the initial time (refer to 
section 3.12.2 for the details). 

o As there are several columns and rows to be reported, the Table will be split 
in two or more sections to fit the page size. 

• Templates - Templates waveforms for each beat type, one type per page (Figure 
136). 

o Templates will follow the QRS complex visualization (refer to section 3.13.3 
for the details). 

o If three or more leads were used in the Beat Detection process, the first three 
leads will be reported. Otherwise in case one or two leads were used, these 
will be printed. 

o Leads will be printed not superimposed and at 50mm/s and 10 mm/mV. 
• Selected ECG Strips (Figure 133, Figure 134 and Figure 135) 

o This choice is only available if ECG Strips have been selected for printing (refer 
to sections 3.7.1.3 and 3.4.11 for details). 

o Strips can be printed in three layouts: 3 or 12 Leads at 25mm/s and 5 mm/mV 
and miniature single-lead at 12.5mm/s and 5 mm/mV. 

▪ In case of 3 leads, these will be II, V2 and V5 in case of a 12 lead 
continuous ECG recording 

▪ In case of miniature, in addition of the ECG signal, drawn in 1, 2 or 3 
lines, depending on the ECG length, a 5 minutes RR, cantered on the 
printed strip, plot is added at the bottom.  

o If the length of the strip is 7s, it will be printed on a single line. Otherwise will 
be split on multiple lines, each of 7s length, with a maximum of 42s. 

• Automatic ECG Strips  
Print automatic ECG strips. The list of the printable automatic strips can be configured 
in the “Automatic Strips Options Dialog” (see section 3.29.3 for details). 

• Full Disclosure - The entire ECG recording signal can be printed in small size (60s per 
line). Three layouts are available 

o 1 Lead (1 hour per page)  
o 2 Leads (30 minutes per page)  
o 3 Leads (20 minutes per page)  

• ST Plot and ST Table, in case episodes of ST Elevation/Depression have been 
identified. 
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o ST Plot reports the maximum Elevation/Depression for each family and on 
each lead; in  case of ST displacement evaluation computed on multiple points, 
the maximum displacement assessed from all points is reported. 

o ST Table reports the list of all episodes of ST displacement, on all analysed 
leads with onset, duration, maximum displacement and average heart rate. 

 

 
Figure 129 – Example of “RR Average Plot”. RR Average, computed over a window of 5 minutes, is visualized 
as the black thin horizontal line. The gray areas report mean ± std and the vertical lines report the extreme 

RR values within each average window 

 
 

 
Figure 130 – Example of “Rhythm Plot”. Rhythm annotations are listed with the number of events and their 

time of occurrence as a black vertical line 
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Figure 131 – Example of “Rhythm List”, listing all episodes of Atrial Fibrillation and Pause. In the Report 

Options dialog it is possible to select which list of events to be included in the report. 

 
 

 
Figure 132 – Example of “Table” where only few columns are reported and with Time bins of an hour size, 

starting at the whole hour 

 
 

 
Figure 133 – Example of “ECG Strip” with 3-Leads layout  
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Figure 134 – Example of “ECG Strip” with 12-Leads layout  

 

 
Figure 135 – Example of “ECG Strip” with a length of 42s in Miniature layout  
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Figure 136 – Example of first page of “Templates” of type N, where leads II, V2 and V5 are reported for the 

QRS complex segment 
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Figure 137 – Example ST segment displacement plot, where ST amplitude on each lead is reported 

 

 
Figure 138 – Example ST segment displacement tale, where for each identified ST episode on each lead, 

onset, duration, maximum displacement, mean heart rate are reported. 
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Figure 139 – Example ST segment displacement tale, where for each identified ST episode on each lead, 

onset, duration, maximum displacement, mean heart rate are reported. 

 

 Review Dialog 
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Figure 140 – Report Review Dialog 

 
In the Review Dialog is possible to: 

• Review the analysis data (read-only) where information about the beats and the 
rhythm annotations is reported 
 

 
 

• Write/Edit comments: the comments are displayed and can be entered/modified 
in the box below. 
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The text displayed in this box will be printed in the “Review” section of the first 
page of the report. 
 

• Add predefined sentences to comments:  

o Using  button it is possible to create a new predefine sentence 
Via the input dialog box in which the comment is typed (see figure below). 

o  

 
 

Pressing the OK button, the typed comment is added to the predefined 
sentences list as shown below. 
 

 
 

o Pressing  button, the selected string is added to the comments. 
o  

 
 

o Pressing  button, the selected string can be modified. 
 
All the created predefined strings are saved in the “PredefinedStrings.txt” configuration file 
available in the folder storing CER-S settings. Refer to Section 3.3 of the System Manual for 
the details. 
The file can be manually edited. Each predefined string must be separated by a newline 
character. 
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 Multiday Analysis ECG Report 

 
Also in case of analyzing multiday recordings, it is possible to print a Continuous ECG Report 

by selecting the “Print Report” entry from the File menu, by clicking the  button. 
Report can be printed to a standard printer or saved in PDF format.  

 
 
The main difference from the standard Report is that Analysis Data, Analysis Settings and 
the reported diagrams are related to Multiday Analysis, thus simplified from for Beat 
Detection and Rhythm Analysis. 
 
In the Analysis Data section, the main results are reported, namely: 

• Overall length of analyzed date and length on noise regions 
• Min/max/mean HR and RR 
• Episodes and overall length of all events  

o Atrial Fibrillation, Atrial Flutter, Atrial Tachycardia 
o Ventricular Fibrillation, Ventricular Flutter, Torsade de Pointes, Ventricular 

Tachycardia 
o AVBs 
o Pauses 

 
In the Analysis Settings section, details of ABILE settings for Multiday Analysis reported, 
namely: 

• Leads used for detection 
• Noise sensitivity level 

 
• Pause threshold  

• Ventricular Tachycardia threshold and minimum length 
• Minimum length of atrial fibrillation, in case the specified value is above 0 s 
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Figure 141 – Example of first page of a Continuous ECG Report, in case of Multiday recording 

 
When the “Print Report” entry has been selected, the “Report Options” dialog is prompted 
(Figure 142 – “Report Options” dialog for the selection of the sections to be included in the 
Multiday report) where it is possible to choose and configure the sections that should be 
included in the report. 
Available sections that can be included in the Continuous ECG Report in case of Multiday 
analysis, are: 
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• “RR Average Plot” - Time RR average plot displays the average values of RR interval 
over time. 

o The size of the window to compute the average RR is customizable, between 
and 1 and 60 minutes. 

• “Rhythms Plot” - Rhythm Annotations against time (Figure 143): number of Rhythm 
Annotations and the time of occurrence for each episode.  

o Rhythm annotations reported in the plot can be limited only to the ones 
available on the given record. 

• “Rhythms List” - List of significant arrhythmias (of the following types) sorted by 
severity and reporting: start time and length 

o Atrial Fibrillation 
o Pauses 
o Ventricular Tachycardia 

• Table - summary information for ECG beats and Rhythm Annotations in tabular 
format (see Figure 132). 

o Table layout follows the one selected for the graphical display, namely the 
columns to be reported, the size of time Bins and the initial time (refer to 
section 3.12.2 for the details). 

o As there are several columns and rows to be reported, the Table will be split 
in two or more sections to fit the page size. 

• Selected ECG Strips 
o This choice is only available if ECG Strips have been selected for printing (refer 

to sections 3.7.1.3 and 3.4.11 for details). 
o Strips can be printed in three layouts: 3 or 12 Leads at 25mm/s and 5 mm/mV 

and miniature single-lead at 12.5mm/s and 5 mm/mV. 
▪ In case of 3 leads, these will be II, V2 and V5 in case of a 12 lead 

continuous ECG recording 
▪ In case of miniature, in addition of the ECG signal, drawn in 1, 2 or 3 

lines, depending on the ECG length, a 5 minutes RR, cantered on the 
printed strip, plot is added at the bottom.  

o If the length of the strip is 7s, it will be printed on a single line. Otherwise will 
be split on multiple lines, each of 7s length, with a maximum of 42s. 

• Automatic ECG Strips  
Print automatic ECG strips. The list of the printable automatic strips can be configured 
in the “Automatic Strips Options Dialog” (see section 3.29.3 for details). 

• Full Disclosure - The entire ECG recording signal can be printed in small size (60s per 
line). Three layouts are available 

o 1 Lead (1 hour per page) 
o 2 Leads (30 minutes per page) 
o 3 Leads (20 minutes per page) 

 
It is possible to configure the report’s language (current available languages are English, 
French and Italian), via the Language drop-down menu. 
The “Center ID” is manually editable and it will be printed on the report’s header. 
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Figure 142 – “Report Options” dialog for the selection of the sections to be included in the Multiday report 

 
 

  
Figure 143 – Example of “RR Average Plot” for Multiday analysis. RR Average, computed over a window of 5 

minutes, is visualized in black 

 
 

 

 Record Information and Demographics 

Selecting “Record Information” or “Record Demographics” from the File menu, it is possible 
to display information related to the ECG recording. 



AMPS-TD-RD-UM-Electra_320 v01 Electra_320 User Manual 

 

 
Property of AMPS llc - Company Confidential Page 152 of 174 

 

 
By selecting the “Record Information” entry, a new dialog (Figure 144) is displayed, 
reporting: 

• Record Information 
o Start date and time of record 
o End date and time of record 
o Sampling rate 
o Amplitude Resolution 
o Number of Leads 
o Lead length, in samples 

• Recorder Information 
o Recorder ID 
o Recorder Name 
o Recorder Software 
o Manufacturer 

• In case an ISHNE record has been loaded, the full ISHNE header is reported 
 
 

    
Figure 144 – Record Information details 

 

By selecting the “Record Demographics” entry or clicking the toolbar button , a new 
dialog with three tabs (Figure 145) is displayed. The dialog reports the following 
information which can be edited: 

• “Subject and Visit” tab 
o Date of Recording 
o Time of Recording 
o Visit ID and related Code System 
o Subject ID, Subject ID Root and Subject Name 
o Date of Birth 
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o Gender 
o Age 

• “Clinical Trial” tab 
o Clinical Trial ID and related ID Root 
o Clinical Trial Protocol ID and related ID Root 
o Site ID, Site ID Root and Site Name 
o Investigator ID, Investigator ID Root and Investigator Name 
o Sponsor ID, Sponsor ID Root and Sponsor Name 

• “Exam” tab 
o Referred by 
o Treatment 
o Comment (this information is reported on the first page of the report 

(section 3.27) 
 

 

      
Figure 145 – Demographic Information 

 
Clicking the Close button, editing will be ignored, while by clicking the Save & Close 
button, all demographic information editing will be saved. 
 

 Options Menu 

 
With this menu it is possible to configure all the available options of the software. These 
include generic and global option as well as those specific to each module, also accessible 
from the specific Option button of the module. 
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 Generic Display Options 

The Drawing Options dialog is invoked by selecting “Display Options” after clicking the 
Options entry of the Menu bar on the top left. 
This dialog allows the user to edit several display options but can also modify options on 
the annotation format. 
 
The Drawing Options dialog is divided into three tabs as described below: 
 

• Annotation Options 
• Signal Options 
• Grid Options 

 
 

- Annotation Options 
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Figure 146 – Drawing Options Dialog, Annotation Options tab 

 
Here different colors can be assigned to the calipers, regions and labels of different 
annotation types. In the Measurements Display section, the user can decide whether to 
visualize calipers, region and labels for every displayed annotation (in case of beat 
annotation which indicates the template’s ID of the beat, it is possible to choose whether 
the category should be displayed or not). 
These options can be customized for each group of annotation. The options available are: 

 

 
 

- Wave annotation 
- Pacemaker waves annotation 
- Beat annotation 
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- Noise annotation 
- Rhythm annotation 
- Amplitude annotation 
- Marker 
- Numeric annotation 
- Time Period 
- Beat annotation unused (beat not considered for the analysis, typically the beats 

under a noise region) 
 
When the Beat annotation group is selected, it is possible to customize the display options 
for some specific type (X, S and V beats). For all the other beat types, the options of the 
Beat annotation group are used. 
 

 
By default, the colors of the label of S and V beats are green and red respectively. 
 
In the Selected Measurement Option, the user can change the color of the area around the 
currently selected measurements. 
 

 
 

- Signal Options 
 
In this tab, the user can choose the color and thickness of the ECG tracing. The signal is 
typically designed continuously, but it can be drawn sample by sample. Finally, the position 
of the ECG samples can be labeled at selected intervals on the tracings. 
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Figure 147 – Drawing Options Dialog, Signal Options tab 

 
 

- Grid Options 
 
The color of the grid can be selected in the Grid Color section. 
 
In this section, it is possible to select display settings to mimic certain layout standards of 
the paper ECGs, such as: 

• Squared grid, paper speed of 25 mm/s and amplitude resolution of 10 mm/mV 
• Squared grid, paper speed of 50 mm/s and amplitude resolution of 20 mm/mV 
• Squared grid, paper speed of 50 mm/s and amplitude resolution of 10 mm/mV 

 
A fourth custom display setting can be configured by the User. 
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Figure 148 – Drawing Options Dialog, Grid Options tab 

 
Two examples of grids are here shown (Figure 149): the first being custom (X: Thick 
Marks=100, Thin Marks=20; Y: Thick Marks=500, Thin Marks=100), and the second 
mimicking a paper speed of 50 mm/s and amplitude resolution of 20 mm/mV.  
 

     
Figure 149 – Two examples (a, b) of ECG grids 

 

 Editing Settings 

 
Selecting the “Editing Settings” entry in the Options menu, it is possible to configure the 
default action to be performed when rhythm annotation events are deleted and the way 
heart rate is computed, as shown here below. 
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Figure 150 – Rhythm Annotations Editing Settings dialog  

 
With the first check-box it is possible to define the action to be performed when standard 
rhythm annotation events, those that can only be added automatically by ABILE algorithm 
(thus excluding Atrial Fibrillation, Atrial Flutter, Atrial Tachycardia, Ventricular Fibrillation, 
Ventricular Flutter, Torsade de Pointes and Atrioventricular blocks) are deleted. 
The default is the second option, where upon the deletion of a standard rhythm annotation 
event, a noise region, replacing the rhythm annotation will be entered. 
With the third option, no action will be performed, only the rhythm annotation will be 
deleted.  
With the first entry by deleting supraventricular and ventricular events (Isolated beat, 
couplets and runs) the beat labels will be automatically relabeled from S and V to N. 
 
With the second check-box it is possible to define the action to be performed when 
heart-rate (HR) events are deleted. 
The default is the first option, where upon the deletion of an HR event, a noise region, 
replacing the event will be entered and this shall be the preferred usage. 
With the second option, no action will be performed upon deletion of an HR event.  
With this latter option, it is very important that HR event review is performed as the very 
last step of a continuous ECG review, without any other editing, otherwise in case editing is 
performed after the HR Events editing, inconsistencies between Table and Annotation 
Summary may be entered. 
 
With the third check-box the user can define the way heart rate is computed every time 
editing is performed: 

• Using all beats available in the 10 s window preceding an ECG beat 
• Using only normal beats (N or S) and thus excluding ventricular beats in the 10 s 

window preceding an ECG beat 
 
In case heart rate of the loaded ECG was computed with a different setting from the current 
one selected in CER-S, the following message is prompted where the user must select which 
heart rate computation strategy shall be applied. 
The choice may affect the current CER-S setting, in fact by selecting Yes, the way to 
compute HR will be switched to the one from the loaded recording. 
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Figure 151 – Rhythm Annotations Editing Settings dialog  

 

 Automatic Strips Selection 

 
Here it is possible to configure for which detected rhythm event automatic ECG strips shall 
be generated, as shown in Figure 152. 
 
The default printable automatic strips are: 

- Longest Atrial Fibrillation 
- Slowest Bradycardia 
- Longest Pause 
- Longest Prolonged RR Interval 
- Fastest Supraventricular Tachycardia 
- Isolated Supraventricular beat having the shortest RR interval 
- Shortest Supraventricular Couplet 
- Longest SV Run 
- Longest SV Bigeminy 
- Longest SV Trigeminy 
- Longest Atrial Flutter 
- Longest Atrial Tachycardia 
- Fastest Ventricular Tachycardia 
- Isolated Ventricular beat having the shortest RR 
- Shortest Ventricular Couplet 
- Longest V Run 
- Longest V Bigeminy 
- Longest V Trigeminy 
- Longest Ventricular Fibrillation 
- Longest Ventricular Flutter 
- Longest Torsade de Pointes 

 
In addition, by selecting the V templates strips it is possible to print one ECG strip for one 
ECG beat of each of the first six ventricular templates. 

 
 



AMPS-TD-RD-UM-Electra_320 v01 Electra_320 User Manual 

 

 
Property of AMPS llc - Company Confidential Page 161 of 174 

 

 
Figure 152 – Automatic Strips Selection dialog 

 

 Keyboard Keys Configuration 

Selecting the “ShortCut Keys” entry in the Options menu, it is possible to configure the 
shortcut keyboard keys to be used in the Continuous ECG Viewer or Rhythm & Beat Editor 
Viewer and in the Templates page and generally in the software. 
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Figure 153 – Short cut keyboard keys configuration 

 
 
Here is the list of available configurable shortcuts, divided by groups: 
 
Beat Measure 

• Move beat detection point to the right (by 1 sample), same as in RBE and 
Templates 

• Move beat detection point to the left (by 1 sample), same as in RBE and Templates 

• Move beat detection point to the right (by 10 samples), same as in RBE and 
Templates 

• Move beat detection point to the left (by 10 samples), same as in RBE and 
Templates 

 
General 

• Save Session 
• Open Recordings Manager 
• Go to previous selected record 
• Go to next selected record 

 
Continuous ECG Viewer and Rhythm & Beat Editor 

• Scroll to next page 
• Scroll to previous page 
• Scroll to next line (1/10 of page) 
• Scroll to previous line (1/10 of page) 

• Go to next item in selection 
• Go to previous item in selection 
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• Go to first item in selection 
• Go to last item in selection 
• Center selected item 
• Select related template 

• Select ECG Strip for printing 
• Review selected ECG strips for printing 
 
Rhythm & Beat Editor (RBE) 
• Go to next beat in time 

• Go to previous beat in time 
• Add new Unknown beat 
• Add new Artefact beat 
• Add new Normal beat 
• Add new Supraventricular beat 

• Add new Ventricular beat 
• Add new Calibration Pulse beat 
• Add new Bundle Branch Block beat 
• Add new Paced beat 
• Add new Ventricular Escape beat 
• Add new Fusion beat 

• Add noise Region 
• Delete selected beat or annotation 
• Relabel selected beat to Unknown 
• Relabel selected beat to Artefact 
• Relabel selected beat to Normal 

• Relabel selected beat to Supraventricular 
• Relabel selected beat to Ventricular 
• Relabel selected beat to Calibration Pulse 
• Relabel selected beat to Bundle Branch Block 
• Relabel selected beat to Paced 

• Relabel selected beat to Ventricular Escape 
• Relabel selected beat to Fusion 
• Adjust beat detection point 
• Move beat detection point to the right (by 1 sample), same as in Templates and 

Beat Measure 
• Move beat detection point to the left (by 1 sample), same as in Templates and Beat 

Measure 
• Move beat detection point to the right (by 10 samples), same as in Templates and 

Beat Measure 
• Move beat detection point to the left (by 10 samples), same as in Templates and 

Beat Measure 
 

Rhythm Analysis 
• Run Rhythm Analysis Full (S beats detection + Rhythms) 
• Detect S beats only 

• Find Rhythms only 
 
Templates 
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• Merge templates 
• Explode template 
• Relabel selected template to Unknown 
• Relabel selected template to Artefact 

• Relabel selected template to Normal 
• Relabel selected template to Supraventricular 
• Relabel selected template to Calibration Pulse 
• Relabel selected template to Bundle Branch Block 
• Relabel selected template to Paced 

• Relabel selected template to Ventricular 
• Relabel selected template to Ventricular Escape 
• Relabel selected template to Fusion 
• Adjust beat detection point for selected template 
• Move beat detection point to the right (by 1 sample), same as in RBE and Beat 

Measure 
• Move beat detection point to the left (by 1 sample), same as in RBE and Beat 

Measure 
• Move beat detection point to the right (by 10 samples), same as in RBE and Beat 

Measure 
• Move beat detection point to the left (by 10 samples), same as in RBE and Beat 

Measure 
• Add noise Region around the ECG beats of the selected template 
• Delete beats of the selected template 

 
Undo 
 
Double-clicking the primary mouse button on a given entry allows the user to modify the 
shortcut. It is also possible to reset short cuts to the default. 
 

 
Figure 154 – Change of shortcut keyboard key for “Scroll to next page” entry 

 
 

 Viewer Options 

From the “Options” menu is possible to reach the viewer options selecting the corresponding 
entry which is: 

- Continuous ECG Viewer (if available) 
- Rhythm & Beat Editor (if available) 

For the details of the available options, see section 3.4.10, on page 22. 
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 Navigation Modules Options 

From the “Options” menu is possible to reach the options of the navigation modules (if 
available). The available options are: 

- Trends (see section 3.11.2, on page 69) 
- Table (see section 3.12.2, on page 78) 
- Templates (see section 3.13.3, on page 84) 
- Histograms (see section 3.14.1, on page 90) 
- Rhythms (see section 3.15.1, on page 96). 

 

 Analysis Options 

From the “Options” menu is possible to reach the various analysis options: 
- Beat Detection (see section 3.20.1.1, on page 113) 
- Rhythm Analysis (see section 3.20.2.1, on page 116) 
- Multiday Detection (see section 3.20.3.1, on page 119) 
- Beat Measures options (see section 3.21.1, on page 122) 
- Templates Generator (see section 3.22.1, on page 129) 

 

 About Menu 

From this menu, the user can display the About dialog (Figure 155) containing information 
regarding the version of CER-S and its software components in the Build Info section. 

 
Clicking the “Activate Log” will activate the logging module that gives detailed information 
for each analysis step (refer to section 3.31 for more details). Clicking on the “Deactivate 
Log”, logging can be disabled. 

  
By clicking the “Plugins” button, a new dialog (Figure 156) showing the details of the loaded 
plugins is visualized. In case of any problem with the software, please contact AMPS 
personnel via support@amps-llc.com email and provide all the Build Info. This information 
can be copied by clicking the “Copy Info” button. 
 

mailto:support@amps-llc.com
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Figure 155 – CER-S About dialog. On the left, the logging has not been activated, while on the dialog on the 

right side, the logging feature has been enabled 

 

 
Figure 156 – CER-S About dialog – Loaded Plugins details 

 
 

 Logging Activation 

It is possible to activate the logging of all activities by clicking on the Activate log button 
from the About menu. 
Refer to section 3.30 for more details on the About Menu. 
The “Logging.txt” log file gets exported in the folder storing CER-S settings, refer to Section 
3.3 of the System Manual for details. 

 Command-line usage 

Apart from the standalone usage with the graphical interface, it is possible to use CER-S 
software via its command-line. 
This usage is ideal for the “aECG Generation”, “Export” “Beat Detection” and “Rhythm 
Analysis” functions in order to conduct them as a batch process. 
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Refer to Section 3.1 of the System Manual for all the details. 
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